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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

1.  Εισαγωγή στη χρήση του Adobe® Flash® CS3 Professional 
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 2 διδακτικές ώρες 

 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα:  

• γνωρίσετε το περιβάλλον εργασίας του Adobe Flash CS3  

• µάθετε να ανοίγετε και να κλείνετε το αρχείο ενός Flash project  

• µάθετε να σχεδιάζεται γραφικά πάνω στη σκηνή και να τα τροποποιείτε 

• µάθετε να κάνετε διάταξη των αντικειµένων 

• µάθετε να δηµιουργείτε διαφανή αντικείµενα 

 

∆ραστηριότητα 1: Γνωριµία µε το περιβάλλον του Adobe® Flash® CS3 
Professional 
 
Βήµα 1ο: ∆ηµιουργώντας ένα νέο project 

Ανοίγοντας την εφαρµογή του Flash, θα συναντήσετε την οθόνη καλωσορίσµατος 

(Welcome screen), στην 

οποία υπάρχουν οι εξής 

κατηγορίες: 

- Open a Recent 

Item 

- Create New 

- Create from 

Template 
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Αυτά είναι συντοµεύσεις για άµεση πρόσβαση σε ορισµένες επιλογές που 

υπάρχουν και στο Κεντρικό Μενού. 

 

Βήµα 2ο: 

Για να δηµιουργήσετε µια νέα εφαρµογή, πηγαίνετε στο Μενού –«File» και 

επιλέξτε –«New». 

 

Βήµα 3ο: 

Στην καρτέλα που θα εµφανιστεί στα «General» επιλέγετε «Flash file(Actionscript 

3.0) » ή «Flash file(Actionscript 2.0) », πατώντας αριστερό κλικ. 

 

 
To περιβάλλον του Adobe Flash CS3 

 

Στο περιβάλλον του Flash υπάρχει µια αυστηρή δοµή για την δηµιουργία των 

εφαρµογών, η οποία αποτελείται από τα εξής στοιχεία: 

• Τα Panel 

• Τα Tools 

• Το Τimeline 

• Τα Layers 

• To Scene 

Κάνετε αντιστοίχηση των παρακάτω στοιχείων του πίνακα µε τους αριθµούς που 

βλέπετε στην εικόνα του «timeline». 
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Χρόνος αναπαραγωγής  

Μενού Timeline   

Αρθµοί καρέ  

Προβολή onion skin  

Τροποποίηση των ενδεικτικών onion  

Τρέχων καρέ  

Κεφαλή αναπαραγωγής  

Κεντρικό καρέ  

Επεξεργασία πολλαπλών καρέ  

Γραµµές κύλισης  

Προβολή onion skin outline  

Ρυθµός καρέ  

 

Αντιστοιχίστε  τα παρακάτω στοιχεία του πίνακα µε τους αριθµούς που βλέπετε στην 

εικόνα της εργαλειοθήκης του Flash. 
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Εργαλείο shape  

Stroke Color   

Τµήµα Options   

Εργαλείο Hand   

Εργαλείο Paint Bucket   

Εργαλείο Arrow   

Εργαλείο Lasso  

Εργαλείο Pencil    

Εργαλείο Text  

Εργαλείο Subselect   

Εργαλείο Pen   

Εργαλείο Eyedropper   

Default Colors   

Fill Color   

Swap color  

Εργαλείο Line   

Εργαλείο Brush   

Εργαλείο Free Transform   

Εργαλείο eraser  

Eργαλείο zoom  

Εργαλείο Ink Bottle   

 

Αναφέρετε τα βασικά πάνελ του Flash 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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∆ραστηριότητα 2: Σχεδιασµός και τροποποίηση απλών γραφικών 
Για να σχεδιάσετε και να τροποποιήσετε απλά γραφικά µε το Flash ακολουθείστε τα 

εξής βήµατα: 

Βήµα 1: Επιλέξτε το εργαλείο «Shape» από την 

εργαλειοθήκη και συγκεκριµένα το «Rectangle Tool» 

(συντόµευση µε το πλήκτρο R). Για να επιλέξετε άλλα 

σχήµατα, απλά κάντε αριστερό κλικ στο κουµπί αυτό και 

στο µενού που εµφανίζεται επιλέγετε το σχήµα που 

θέλετε. 

 

Βήµα 2: Κρατώντας πατηµένο το 

αριστερό πλήκτρο του ποντικιού 

δηµιουργείτε στη σκηνή του flash ένα 

ορθογώνιο σχήµα και αφήνετε το 

αριστερό πλήκτρο µόλις πάρει το 

σχήµα που θέλετε. 

 

Βήµα 3: Περιστρέφετε το αντικείµενο χρησιµοποιώντας το «Free transform tool» που 

υπάρχει στην εργαλειοθήκη του Flash. Το συγκεκριµένο εργαλείο σάς επιτρέπει να 

περιστρέψετε αλλά και να µεγεθύνετε – µικρύνετε το επιλεγµένο αντικείµενο. 

 

 

Τι αντιπροσωπεύουν τα 8 σηµεία λαβής (µαύρα τετραγωνάκια) που υπάρχουν στο 

περίγραµµα του σχήµατός µας όταν επιλέγετε «free transform» και τι αντιπροσωπεύει 

η άσπρη κουκκίδα στο κέντρο του σχήµατος; 
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..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................  

Πώς µπορείτε να φτιάξετε έναν τέλειο κύκλο µε τα εργαλεία του Flash; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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∆ραστηριότητα 3: Σχεδιασµός πιο σύνθετων γραφικών σε µονό layer 
Τα παρακάτω βήµατα περιγράφουν τη διαδικασία δηµιουργίας πιο σύνθετων 

γραφικών µε το Flash: 

 

Βήµα 1: Επιλέγετε το εργαλείο «Shape» από την 

εργαλειοθήκη και συγκεκριµένα το «Rectangle Tool» 

(συντόµευση µε το πλήκτρο R). Για να επιλέξετε άλλα 

σχήµατα, απλά κάντε αριστερό κλικ στο κουµπί αυτό και 

στο µενού που εµφανίζεται επιλέγετε το σχήµα που 

θέλετε. 

 

Βήµα 2: Κρατώντας πατηµένο το αριστερό πλήκτρο του ποντικιού δηµιουργείτε στη 

σκηνή του Flash ένα ορθογώνιο σχήµα και αφήνετε το αριστερό πλήκτρο µόλις πάρει 

το σχήµα που θέλετε. 

 

Βήµα 3: Με τον ίδιο ακριβώς τρόπο και 

διαλέγοντας και άλλα σχήµατα («Polystar tool») 

δηµιουργείτε το σχήµα της διπλανής εικόνας. 

 

Βήµα 4: Για να αλλάξετε το χρώµα 

του αντικειµένου, το επιλέγετε µε το 

ποντίκι και χρησιµοποιείτε τις 

επιλογές χρωµάτων («fill color» και 

«stroke color») στο παράθυρο των 

ιδιοτήτων στο κάτω µέρος της οθόνης 

για να δώσετε το επιθυµητό χρώµα.  
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Βήµα 5: Τελειοποιείτε το σχήµα σας 

φτιάχνοντας κύκλους µε το εργαλείο «Shape», 

όπως κάνατε και στα βήµατα 1-2. Αλλάζετε 

τα χρώµατά τους, έτσι ώστε να εµφανιστεί το 

σχήµα της διπλανής εικόνας. 

 

Ποια η διαφορά του «STROKE COLOR» από  το «FILL COLOR»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

......................................................................................................................................... 

Πώς µπορείτε να φτιάξετε το περίγραµµα ενός σχήµατος µε διακεκοµµένες κουκίδες; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………….. 

Τι αντιπροσωπεύει η ιδιότητα «ALPHA» στο χρώµα ενός σχήµατος; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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∆ραστηριότητα 4: Σχεδιασµός διαφανών 
αντικειµένων 
Για να σχεδιάσετε διάφανα ή ηµιδιάφανα γραφικά 

µε το Flash ακολουθοείτε τα εξής βήµατα: 

 

Βήµα 1: ∆ηµιουργείτε δύο σχήµατα 

στη σκηνή του Flash π.χ. µε το «Rectangle tool». Φροντίζετε να 

επικαλύπτει το ένα το άλλο. Μπορείτε να τα µετακινήσετε µε το 

«Selection tool» όπου θέλετε. 

 

 

 

Βήµα 2: Επιλέγετε µε το ποντίκι το σχήµα που 

είναι ορατό ολόκληρο σε εσάς και επιλέγετε το 

εικονίδιο «Fill color» που βρίσκεται στο 

παράθυρο των ιδιοτήτων στο κάτω µέρος της 

οθόνης. Στην παλέτα χρώµατος που θα 

εµφανιστεί επιλέγετε κάποιο χρώµα π.χ. πράσινο.  

  

 

Βήµα 3: Πηγαίνετε πάλι στην παλέτα χρωµάτων και 

συγκεκριµένα στην επιλογή «Alpha» όπου και επιλέγετε 

κάποια τιµή αδιαφάνειας (όσο µικρότερη η τιµή, τόσο πιο 

διαφανές το αντικείµενο). 

 

 

Βλέπετε ότι το πράσινο τετράγωνο έχει γίνει διαφανές 

και πίσω του φαίνεται το µπλε τετράγωνο. Μπορείτε 

να πειραµατιστείτε µε διάφορες τιµές «Alpha» για να 

πετύχετε το επιθυµητό αποτέλεσµα. 
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Τι θα συµβεί αν δώσετε τιµή 0 στο πεδίο «ALPHA»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Μπορείτε να έχουµε πολλά ηµιδιαφανή αντικείµενα το ένα πάνω από το άλλο; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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∆ραστηριότητα 5: Κατανόηση διάταξης και οµαδοποίησης αντικειµένων 
 

 

Έχετε τα αντικείµενα, που βλέπετε στην εικόνα δεξιά, 

πάνω στη σκηνή του Flash και παρατηρείτε ότι ο ήλιος 

πέφτει πάνω στο πολύγωνο ως διαφάνεια. 

 

 

 

Μπορείτε να µεταφέρετε το 

πολύγωνο µπροστά από τον ήλιο, 

κάνοντας δεξί κλικ στο αντικείµενο 

και στις επιλογές «arrange» επιλέγετε 

«send to back». 

 

 

 

 

∆οκιµάστε να παίξετε µε τα αντικείµενα, πατώντας και τις υπόλοιπες επιλογές του  

«Arrange». Τι παρατηρείτε;  

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………................................................................
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Επιλέξτε το πάνελ µε την καρτέλα «Align». Θα 

παρατηρήσετε ότι έχει αρκετές επιλογές, ανάλογα µε 

την διάταξη που θέλετε να κάνετε στα αντικείµενα. 

 

 

 

∆οκιµάστε τις διάφορες επιλογές. Τι συµπέρασµα βγάζετε; Σχολιάστε τα 

αποτελέσµατα. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

......................................................................................................................................... 

..........................................................................................................................................  
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

2. Σύµβολα στο Flash και βασική κίνηση 
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 2 διδακτικές ώρες 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας θα:  

• µάθετε να εργάζεστε σε πολλαπλά layers 

• κατανοήσετε τα layers και θα σχεδιάζετε γραφικά σε περισσότερα από ένα 

layer  

• γνωρίσετε τα σύµβολα και θα µπορείτε να τα δηµιουργείτε 

• µάθετε να χρησιµοποιείτε γραφικά στο Flash, που έχουν δηµιουργηθεί από 

άλλες εφαρµογές 

• µάθετε να δηµιουργείτε animation 

 

∆ραστηριότητα 1:∆ηµιουργία γραφικών σε πολλαπλά layers 
Ανοίγοντας το Flash παρατηρείτε ότι σαν 

default ρυθµίσεις υπάρχει µόνο ένα layer στο 

σκηνικό. 

Για να δηµιουργήσετε κι άλλα layers, µπορείτε 

να κάνετε το εξής:  

Πηγαίνετε πάνω στο Layer 1 και πατήστε δεξί 

κλικ. Στο µενού που εµφανίζεται επιλέξτε <<Insert Layer>>. Εναλλακτικά µπορείτε 

να κάνετε αριστερό κλικ στο εικονίδιο µε την κενή σελίδα που βρίσκεται στο κάτω 

αριστερό µέρος της διπλανής εικόνας. 

Μπορείτε µε τον ίδιο τρόπο να δηµιουργήσετε όσα layer θέλετε, ανάλογα µε τις 

απαιτήσεις της εργασίας σας. 
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Για να σχεδιάσετε γραφικά σε πολλαπλά Layers 

ακολουθείστε τα παρακάτω βήµατα: 

Βήµα 1ο:  Επιλέξτε το Layer, στο οποίο θέλετε να 

σχεδιάσετε.  

Βήµα 2ο: Με την βοήθεια της εργαλειοθήκης 

σχεδιάστε τα γραφικά της αρεσκείας σας. 

Βήµα 3ο: Συνεχίστε την διαδικασία, επιλέγοντας κάθε φορά το επιθυµητό Layer. 

Να προσέχετε πάντα σε ποιο layer σχεδιάζετε, γιατί δουλεύοντας µε πολλά layers, 

είναι πιθανό να µπερδευτείτε, µε αποτέλεσµα να σχεδιάσετε σε διαφορετικό από το 

επιθυµητό layer. 

 

Αναφέρετε περιπτώσεις στην πραγµατική ζωή, όπου χρησιµοποιούµε layers. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Σε τι µας βοηθά η χρήση layers κατά τη γνώµη σας; Γιατί να µη βάλουµε όλα τα 

γραφικά σε ένα layer; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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∆ραστηριότητα 2: Κατανόηση και οργάνωση των layers στο Macromedia Flash 
Όταν έχετε πολλά layers ταυτόχρονα στη σκηνή σας, καλό θα είναι να τα οργανώσετε 

σε φακέλους δίνοντάς τους ονόµατα.  

Στα layers µπορείτε να δώσετε κάποιο όνοµα για να 

ξέρετε τι περιέχουν. Απλά κάντε διπλό κλικ π.χ. στο 

layer 4 και δώστε κάποιο άλλο όνοµα. Για παράδειγµα, 

αν ένα layer περιέχει ένα αυτοκινητάκι, τότε µπορείτε 

να του δώσετε το όνοµα “car”. Έτσι, θα ξέρετε την επόµενη φορά σε ποιο layer 

βρίσκεται το αντικείµενό σας και θα το εντοπίσετε γρηγορότερα. Επίσης, σηµαντική 

λεπτοµέρεια είναι ότι µε απλό κλικ πάνω στο όνοµα του layer, αυτοµάτως θα 

επιλεχθούν τα αντικείµενα που υπάρχουν µέσα σε αυτό. 

Μπορείτε  να αλλάξετε τη σειρά των layers, έτσι 

ώστε τα γραφικά που έχετε σχεδιάσει να 

τοποθετηθούν στο επιθυµητό βάθος. Για να το 

πετύχετε αυτό, κάντε drag ‘n’ drop το layer µε 

το ποντίκι σας και το τοποθετείστε στη θέση 

που θέλετε. Όπως βλέπετε στη διπλανή εικόνα, 

τα γραφικά που βρίσκονται σε layers που είναι τοποθετηµένα πιο ψηλά στη λίστα, 

εµφανίζονται πάνω από τα υπόλοιπα layers.  

 

Αν µετακινήσετε το layer “wheels” µε το 

ποντίκι και το πάτε κάτω από το layer “car” 

θα δείτε ότι οι ρόδες του αυτοκινήτου θα 

πάνε πίσω από το αυτοκίνητο. 

 

 

Για να οργανώσετε τα layers σε φακέλους κάντε τα εξής: 

Βήµα 1ο: Έστω ότι έχετε τα 10 layers που φαίνονται στη 

διπλανή εικόνα. Αν και έχουν ονόµατα, είναι δύσκολο να 

τα οργανώσετε, έτσι π.χ. που ο δρόµος να πάει πίσω από τα 

υπόλοιπα µέρη του αυτοκινήτου.  
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Θα χρησιµοποιήσετε την επιλογή <<Insert Layer Folder>> που 

βρίσκεται κάτω από τα layers και σας δίνει τη δυνατότητα να 

δηµιουργήσετε έναν φάκελο.  

 

Βήµα 2ο: ∆ώστε στο φάκελο ένα όνοµα που περιγράφει 

τι αντικείµενα βρίσκονται µέσα σε αυτόν π.χ. 

<<καµπίνα αυτοκινήτου>>. 

 

Βήµα 3ο: Σύρατε µε drag’n’drop τα layers 

<<τιµόνι>>, <<οδηγός>>, <<συνοδηγός>> µέσα στο 

φάκελο που δηµιουργήσατε. Παρατηρείτε ότι τα 

layers που σύρατε 

έχουν µεταφερθεί 

λίγο πιο δεξιά στη λίστα. Έτσι, καταλαβαίνετε ότι 

βρίσκονται µέσα στον φάκελο. Αν θέλετε, κάντε κλικ στο βελάκι που βρίσκεται 

αριστερά από το φάκελο για να κρύψετε τα ονόµατα των αντικειµένων που 

βρίσκονται στη λίστα.  

Βήµα 4ο: Ακολουθώντας πάλι τα βήµατα 1-3 φτιάξτε και 

τους υπόλοιπους φακέλους που χρειάζεστε, έτσι ώστε να 

καταλήξετε  στη διπλανή εικόνα. 

 

 

 

 

Με το Flash σας δίνεται η δυνατότητα να κρύψετε από τη σκηνή τα layers που δε 

θέλετε και να κλειδώσετε όσα θέλετε για να µην τα µετακινήσετε κατά λάθος. 
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Για να κρύψετε ένα layer: 

Κάντε κλικ στην µικρή κουκίδα, 

που βρίσκεται κάτω από το 

εικονίδιο που συµβολίζεται µε ένα 

µάτι, στο layer που θέλετε να 

κρύψετε. ∆είτε ότι η κουκίδα 

αντικαθίσταται µε ένα κόκκινο Χ 

και το layer εξαφανίζεται. 

Για να το εµφανίσετε, κάντε το 

αντίστροφο – δηλαδή κλικ στο 

κόκκινο X και το layer 

εµφανίζεται πάλι στη σκηνή σας. 

 

 

 

Αν έχετε πολλά layer και θέλετε να τα κρύψετε όλα, τι θα πατήσετε;  

.......................................................................................................................................... 

 

Για να κλειδώσετε ένα layer: 

Κάντε κλικ στην µικρή κουκίδα, που 

βρίσκεται κάτω από το εικονίδιο που 

συµβολίζεται µε ένα λουκέτο, στο layer που 

θέλετε να κλειδώσετε. Βλέπετε ότι η κουκίδα 

αντικαθίσταται µε ένα µικρό λουκέτο. Στο layer αυτό τώρα δεν µπορείτε να κάνετε 

καµία διαδικασία (π.χ. να σχεδιάσετε ή να επιλέξετε ένα αντικείµενο) παρά µόνο να 

το διαγράψετε ή να το ξεκλειδώσετε πάλι. 

 

Για να το ξεκλειδώσετε τι θα κάνετε;  

..........................................................................................................................................

.......................................................................................................................................... 

 

Βάλτε στη σειρά τις λέξεις: σύννεφο, ουρανός, γη, ήλιος, πουλιά, από το χαµηλότερο 

στο υψηλότερο layer που θα πρέπει να µπουν έτσι ώστε να σχηµατιστεί σωστά µια 

εικόνα χωρίς π.χ. ο ουρανός να υπερκαλύπτει τα πουλιά. 
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..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Ποια η διαφορά απόκρυψης και κλειδώµατος των layers; Έχει νόηµα ένα layer να 

είναι κρυµµένο και κλειδωµένο ταυτόχρονα; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

∆ραστηριότητα 3: ∆ηµιουργία και χρήση συµβόλων 
Τις περισσότερες φορές στο Flash χρειάζεται να αποθηκεύσετε κάποια αντικείµενα 

στη σκηνή για να έχετε εύκολη και γρήγορη πρόσβαση. Αυτό γίνεται µε τη χρήση 

συµβόλων. 

Για να δηµιουργήσετε ένα σύµβολο στο Flash, ακολουθείστε τα παρακάτω βήµατα:  

 

Βήµα 1ο: Επιλέξτε τα αντικείµενα που θέλετε να 

αποτελούν το σύµβολό σας. Στη συγκεκριµένη 

περίπτωση µετατρέψτε σε σύµβολο το αυτοκίνητο, 

έτσι ώστε να το χρησιµοποιήσετε πολλές φορές µέσα 

στη σκηνή σας. Το επιλέγετε κάνοντας κλικ στο 

layer στο οποίο βρίσκεται ή επιλέγοντας ένα-ένα τα στοιχεία που το απαρτίζουν. 

 

 

Βήµα 2ο: Επιλέξτε από το µενού <<Modify>> / << 

Convert to 

Symbol>>. 

Εµφανίζεται ένα 

παράθυρο διαλόγου που σας προτρέπει να 

ονοµάσετε το σύµβολο που θέλετε να δηµιουργήσετε. Ονοµάστε το <<car_symbol>>, 

αφήστε τις άλλες παραµέτρους ως έχουν και πατήστε Οk. 
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Βήµα 3ο: Το σύµβολο τώρα έχει εισαχθεί στη βιβλιοθήκη του 

flash και µπορείτε να το χρησιµοποιήσετε όσες φορές θέλετε 

απλά κάνοντάς το drag’n’drop µέσα στη σκηνή. Με τον 

τρόπο αυτό 

δηµιουργούν

ται όσα 

στιγµιότυπα 

(instances) του αντικειµένου 

χρειάζεστε. Μεγάλο  πλεονέκτηµα των συµβόλων είναι η εξοικονόµηση χώρου και η 

ευκολία αλλαγής ιδιοτήτων όλων των στιγµιότυπων, αλλάζοντας απλά µία φορά την 

ιδιότητα του συµβόλου. 

Για να αλλάξετε π.χ. το χρώµα σε όλα τα 

αυτοκίνητα κάντε 

διπλό κλικ στο 

σύµβολο που βρίσκεται στη βιβλιοθήκη και αλλάξτε 

το µπλε χρώµα µε κάποιο άλλο χρησιµοποιώντας την 

ιδιότητα fill color. Επιστρέψτε στη σκηνή για να 

δείτε το αποτέλεσµα µε το βελάκι που έχει εµφανιστεί κάτω από το timeline. 

Βλέπετε ότι όλα τα αυτοκίνητα στη σκηνή σας 

άλλαξαν στο χρώµα που επιλέξατε χωρίς να 

µπείτε ξεχωριστά µέσα στο καθένα.  

 

Αναφέρετε 3 πλεονεκτήµατα της χρήσης συµβόλων. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Ποιος είναι ο µικρότερος αριθµός συµβόλων που 

µπορεί να χρησιµοποιηθεί για να εµφανιστεί η διπλανή 

εικόνα; 
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…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

∆ραστηριότητα 4: Χρήση γραφικών που δεν δηµιουργήθηκαν στο flash 
Για να εισάγετε στο Flash γραφικά που κατασκευάστηκαν µε κάποιο άλλο 

πρόγραµµα επεξεργασίας εικόνας ακολουθείστε τα εξής βήµατα: 

 

Βήµα 1ο: Ενεργοποιείστε ένα layer κάνοντας 

κλικ πάνω στο όνοµά του.  

 

Βήµα 2ο: Επιλέξτε «File/Import/Import to 

Stage» ή «File/Import/Import to Library» 

αντίστοιχα, αν θέλετε το γραφικό να 

εµφανιστεί απευθείας στη σκηνή ή στη 

βιβλιοθήκη του Flash. Στο συγκεκριµένο 

παράδειγµα επιλέξτε «Import to Stage». 

Στο ακόλουθο παράθυρο διαλόγου επιλέξτε το αρχείο που περιέχει το γραφικό που 

θέλετε να εισάγετε και πατήστε <<Οpen>>. 
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Βήµα 3ο:  

Το γραφικό σας εισάγεται στο flash 

και µπορείτε τώρα να το 

µετατρέψετε σε σύµβολο ή να 

κάνετε όποια άλλη επεξεργασία 

χρειάζεστε (µεγέθυνση, σµίκρυνση 

κ.α.). 

 

 

 

Έστω ότι έχετε εισάγει στο flash ένα γραφικό και το έχετε µετατρέψει σε σύµβολο. Τι 

θα γίνει αν σβήσετε το γραφικό από τη σκηνή και τι αν σβήσετε το γραφικό από τη 

βιβλιοθήκη; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Μπορείτε µε τη χρήση του «Fill Color» και «Stroke Color» να αλλάξετε το χρώµα 

ενός γραφικού που έχετε εισάγει στη σκηνή σας; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

∆ραστηριότητα 5: ∆ηµιουργία βασικών animation 
καρέ-καρέ 
Για να δηµιουργήσετε ένα βασικό animation µε τη 

χρήση frames ακολουθείστε τα εξής βήµατα: 

 

Βήµα 1ο: ∆ηµιουργήστε ένα σχήµα από την 

εργαλειοθήκη του Flash. Στο παράδειγµα έχει φτιαχτεί 



ΤΕΤΡΑ∆ΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 24 

ένας κύκλος. Αυτός αυτόµατα τοποθετείται στο πρώτο frame του timeline της σκηνής 

µας. ∆ώστε ένα χρώµα στο αντικείµενο. 

 

Βήµα 2ο: Τοποθετήστε το ποντίκι στο frame που βρίσκεται ο 

κύκλος που φτιάξατε και πατήστε δεξί κλικ. Στο µενού που 

εµφανίζεται επιλέξτε <<Copy frames>>. Με την επιλογή 

αυτή, ό,τι περιέχει το συγκεκριµένο frame (στην περίπτωση 

αυτή ο κύκλος) αποθηκεύεται στη µνήµη.  

 

 

Βήµα 3ο: Πηγαίνετε στο αµέσως επόµενο frame (frame 2) 

του timeline και κάντε δεξί κλικ και <<Paste frames>>. Ο 

κύκλος του προηγούµενου frame αντιγράφεται αυτόµατα σε 

αυτό το frame και στην ίδια ακριβώς θέση. 

 

 

 

Βήµα 4ο: Επιλέξτε µε το ποντίκι τον κύκλο που 

βρίσκεται στο δεύτερο frame και µετατοπίστε τον λίγο 

πιο δεξιά µε τα βελάκια του πληκτρολογίου. Τώρα 

έχετε 2 frame ενός animation. 

 

Βήµα 5ο: Επαναλάβετε τα βήµατα 2-4, επιλέγοντας 

κάθε φορά το τελευταίο frame που έχετε φτιάξει, έτσι 

ώστε να κατασκευάσετε 5 καρέ διαδοχικής κίνησης 

του κύκλου σας. 

 

 

Για να αναπαράγετε καρέ-καρέ την κίνηση του 

κύκλου πατήστε <<Enter>> ή επιλέξτε 

«Control/Play» από το µενού του Flash.  
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Πώς µπορείτε να δηµιουργήσετε animation µε πολλά αντικείµενα ταυτόχρονα (π.χ. 

ένα κύκλο, ένα τετράγωνο και ένα αστέρι που µετακινούνται σε τυχαίες και 

διαφορετικές κατευθύνσεις το καθένα); 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Τι θα συµβεί αν αλλάξετε τον ρυθµό καρέ, από 12 που είναι προεπιλεγµένο σε 24; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

3. Κίνηση και επεξεργασία σχήµατος  
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 3 διδακτικές ώρες 

 

 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα:  

• µάθετε να µετακινείτε, να περιστρέφετε και να αλλάζετε την κλίµακά  των 

γραφικών σας 

• µάθετε να εφαρµόζετε χρωµατικά εφέ στα γραφικά  

• µάθετε να δηµιουργείτε κίνηση (animation) µε motion tweening  

• µάθετε να µετακινείτε αντικείµενα κατά µήκος συγκεκριµένης διαδροµής  

• µάθετε να µετασχηµατίζετε αντικείµενα  (shape tweening) 

• µάθετε να δηµιουργείτε αντικείµενα που ταυτόχρονα µετακινούνται και 

µετασχηµατίζονται 

 

 

∆ραστηριότητα 1: Μετακίνηση, περιστροφή, αλλαγή κλίµακας γραφικών   
Βήµα 1ο.  Ζωγραφίστε ένα ορθογώνιο. 

 

Βήµα 2ο. Θα µπορούσατε να κάνετε όλα τα επόµενα βήµατα της παρούσας 

δραστηριότητας χωρίς να το µετατρέψετε σε σύµβολο. Αλλά επειδή σε αυτό το 

φύλλο εργασίας πρόκειται να µάθετε motion tweening, το οποίο εφαρµόζεται στα 

στιγµιότυπα συµβόλων, µετατρέψτε το ορθογώνιο αυτό σε σύµβολο. ∆ώστε του 

όνοµα Orthogonio. Τώρα στη σκηνή σας πρέπει να έχετε ένα στιγµιότυπο του 

συµβόλου αυτού. Επιλέξτε  το.  

 

Βήµα 3ο.  Αλλάξτε την τοποθεσία του είτε σέρνοντάς το µε το ποντίκι, είτε 
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χρησιµοποιώντας βελάκια (arrow keys), είτε µε το «Property inspector» εισάγοντας 

τις τιµές για το x και το y, είτε µε το «Info panel».  

 

Βήµα 4ο. Για να περιστρέψετε το ορθογώνιο επιλέξτε  το εργαλείο «Free Transform». 

Τοποθετήστε τον δείκτη του ποντικιού λίγο έξω από την γωνιακή λαβή και σύρτε 

την. 

 
Βήµα 5ο.  Για την αλλαγή της κλίµακας, σέρνετε τη λαβή στο πλάι ή τη γωνιακή 

λαβή τοποθετώντας τον δείκτη του ποντικιού πάνω τους. 

 

 
 

∆οκιµάστε να περιστρέψετε το ορθογώνιο και να αλλάξετε την κλίµακά του και µε 

τον παρακάτω τρόπο: ανοίξτε το µενού «Modify > Transform», επιλέξτε «Scale and 

rotate» και εισάγετε αντίστοιχες τιµές. 

Αν εισάγετε έναν αρνητικό αριθµό στο «Rotate» του παραθύρου «Scale and rotate», 

σε ποια κατεύθυνση θα περιστραφεί το ορθογώνιο;   

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

......................................................................................................................................... 
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∆ραστηριότητα 2: Εφέ χρώµατος στα γραφικά  
Κάθε στιγµιότυπο (instance) ενός συµβόλου µπορεί  να έχει δικό του χρωµατικό εφέ, 

το οποίο ορίζεται στο «Property inspector». 

 

Βήµα 1ο.  Επιλέξτε  το  στιγµιότυπο του συµβόλου του ορθογωνίου από την 

προηγούµενη δραστηριότητα και, αν δεν βλέπετε το «Property inspector», επιλέξτε 

«Window > Properties > Properties».  

 

Βήµα 2ο. Από το µενού «Color» του «Property inspector» µπορείτε να επιλέξετε µια 

από τις επιλογές (Brightness, Tint, Alpha, Advanced), την οποία µπορείτε να 

ρυθµίσετε. Εδώ επιλέξτε «Tint». 

 

Βήµα 3ο. Όταν επιλέγετε «Tint», εµφανίζεται δίπλα η δυνατότητα επιλογής 

χρώµατος. Επιλέξτε κάποιο άλλο χρώµα για το συγκεκριµένο στιγµιότυπο (αυτή η 

επιλογή δεν επηρεάζει το χρώµα του ίδιου του συµβόλου).  

 
 

Πώς µπορείτε να αλλάξετε το χρώµα του ίδιου του συµβόλου; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

∆οκιµάστε να εφαρµόσετε χρωµατικό εφέ στο στιγµιότυπο του συµβόλου του 

ορθογωνίου επιλέγοντας «Brightness» και «Alpha» από το µενού «Color» του 

«Property inspector».  

 



ΤΕΤΡΑ∆ΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 29 

∆ραστηριότητα 3: ∆ηµιουργία κίνησης (animation) µε motion tweening  
Στην εφαρµογή Flash υπάρχει δυνατότητα δηµιουργίας  tweening δύο ειδών: 

• motion tweening – όταν αλλάζουν οι ιδιότητες αντικειµένου µε χρόνο, όπως 

θέση, µέγεθος, γωνία περιστροφής, χρώµα κτλ., τις οποίες µάθατε να 

αλλάζετε στις προηγούµενες δραστηριότητες του παρόντος φύλλου 

• shape tweening - όταν αλλάζει το σχήµα αντικειµένου µε χρόνο 

Σ’ αυτή τη δραστηριότητα θ’ ασχοληθείτε µε το πρώτο είδος του tweening - motion 

tweening.  

Πρέπει να ορίσετε τις ιδιότητες ενός αντικειµένου σε ένα αρχικό καρέ-κλειδί 

(keyframe) και ύστερα να τις αλλάξετε στο επόµενο καρέ-κλειδί. Το Flash θα 

δηµιουργήσει µόνο του την κίνηση για όλα τα ενδιάµεσα καρέ. 

 

Βήµα 1ο.  Στο προηγούµενο φύλλο εργασίας µάθατε να δηµιουργείτε σύµβολα. Με 

τον δείκτη τρέχοντος καρέ στο καρέ 1 της χρονογραµµής (Timeline) ζωγραφίστε ένα 

ορθογώνιο και µετατρέψτε το σε σύµβολο. Στη σκηνή τώρα βρίσκεται ένα 

στιγµιότυπό του συµβόλου αυτού (θα µπορούσε να χρησιµοποιηθεί ένα έτοιµο 

σύµβολο από τη βιβλιοθήκη. Σε αυτή την περίπτωση θα το σέρνατε από τη 

βιβλιοθήκη στο σκηνικό (Stage) µε το ποντίκι). Τοποθετήστε το στην αριστερή 

πλευρά του σκηνικού - εκεί που θέλετε να εµφανίζεται όταν ξεκινά η κίνησή του. 

 

Βήµα 2ο: Επιλέξτε καρέ 30 στη χρονογραµµή (Timeline) και µετατρέψτε το σε καρέ-

κλειδί πατώντας F6 ή επιλέξτε «Insert > Timeline > Keyframe». Με τον δείκτη 

τρέχοντος καρέ στο καρέ 30, µετακινήστε το στιγµιότυπο του συµβόλου, 

περιστρέψετε το, αλλάξετε την κλίµακά του και να εφαρµόστε σε αυτό χρωµατικό 

εφέ.  

 

Βήµα 3ο: Επιλέξτε οποιοδήποτε καρέ ανάµεσα στο 1 και 30.  

 

Βήµα 4ο: Κάντε δεξί κλικ σ’ αυτό το καρέ και επιλέξτε Create Motion Tween. Για να 

ορίσετε διάφορες παραµέτρους του motion tweening, µπορείτε να επιλέξτε «Motion» 

από την αναδιπλούµενη λίστα (pop-up µενού) «Tween» στο «Property inspector». 

Εάν αλλάξατε το µέγεθος του στιγµιότυπου, πρέπει να είναι επιλεγµένο το «Scale» 

στο «Property inspector».  
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Βήµα 5ο. Για να δείτε τι δηµιουργήσατε, κάντε κλικ στο πρώτο καρέ της 

χρονογραµµής (Timeline) και πατήστε το Enter ή επιλέξτε «Control > Test Movie». 

Σηµείωση: Κατά τη δηµιουργία του motion tweening πρέπει να έχετε µόνο ένα 

αντικείµενο στο αντίστοιχο layer. 

Με πόσους τρόπους µπορούµε να δηµιουργήσουµε ένα «motion tweening»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

 

∆ραστηριότητα 4: Μετακίνηση αντικειµένων κατά µήκος συγκεκριµένης 
διαδροµής  
Μέχρι τώρα στο motion tweening ορίζαµε την αρχική και την τελική θέση του 

αντικειµένου. Η εφαρµογή Flash δηµιουργούσε την κίνηση για όλα τα ενδιάµεσα 

καρέ, δηµιουργώντας µια γραµµική µεταβολή µεταξύ της αρχικής και της τελικής 

κατάστασης. Όµως, µπορεί να ορίζεται διαφορετική διαδροµή αντί για την ευθεία που 

προκύπτει από τη γραµµική µεταβολή για τις µεταβολές της θέσης του αντικειµένου. 

Ακολουθήστε τα παρακάτω βήµατα για να το υλοποιήσετε: 

 

Βήµα 1ο.  Επιλέξτε  το layer, το οποίο περιέχει το motion-tweened animation και 

επιλέξτε  «Insert  > Timeline > Motion Guide».  

 

Βήµα 2ο. Έτσι, δηµιουργείται καινούργιο layer πάνω από το επιλεγµένο, το οποίο 

έχει όνοµα «Guide:» και το όνοµα του layer που πάνω του βρίσκεται το στιγµιότυπο.  

 

Βήµα 3ο. Ζωγραφίστε την επιθυµητή διαδροµή σ’ αυτό το layer χρησιµοποιώντας το 

µολύβι της εργαλειοθήκης.  
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Βήµα 4ο. Στο καρέ 1 ευθυγραµµίστε το κέντρο του κινούµενου αντικειµένου  µε την 

αρχή της γραµµής διαδροµής και στο τελευταίο καρέ ευθυγραµµίστε το κέντρο του 

κινούµενου αντικειµένου  µε το τέλος της γραµµής. 

 

Βήµα 5ο. Για να δείτε τι δηµιουργήσατε «τρέξτε» την εφαρµογή σας πατώντας 

control και enter. 

 

Ποια είναι κατά την γνώµη σας τα πλεονεκτήµατα ενός «guide layer»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

∆ραστηριότητα 5: Μεταµόρφωση αντικειµένων (Shape Tweening) 
Σ’ αυτή τη δραστηριότητα θ’ ασχοληθείτε µε το δεύτερο είδος του tweening (shape 

tweening), το οποίο µετασχηµατίζει ένα σχήµα σε ένα άλλο. Εσείς σχεδιάζετε 

σχήµατα σε δύο καρέ-κλειδιά και η εφαρµογή Flash παράγει τα ενδιάµεσα καρέ. 
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Βήµα 1ο:  Σε ένα νέο αρχείο σχεδιάστε έναν κύκλο στη σκηνή. Μην το µετατρέψετε 

σε σύµβολο.  

 
 

Βήµα 2ο: Επιλέξτε το καρέ 30 στη χρονογραµµή (Timeline) και µετατρέψτε το σε 

καρέ- κλειδί πατώντας F6 ή επιλέξτε «Insert > Timeline > Keyframe». Αυτό το καρέ  

θα είναι ίδιο µε το πρώτο καρέ. 

 

Βήµα 3ο: Επιλέξτε το καρέ 15 στη χρονογραµµή (Timeline) και µετατρέψτε και αυτό 

το καρέ σε καρέ-κλειδί πατώντας F6 ή επιλέξτε «Insert > Timeline > Keyframe».  

 

Βήµα 4ο: Με τον δείκτη τρέχοντος καρέ στο καρέ 15 κάντε µία µικρή αλλαγή στον 

κύκλο ως εξής: µε το εργαλείο επιλογής κάντε κλικ κάπου έξω από τον κύκλο και 

τοποθετήστε το δείκτη κοντά στην περιφέρεια του κύκλου, µέχρι να εµφανίσει ένα 

τόξο κάτω από το βέλος. Κάντε κλικ και σύρτε το λίγο προς το κέντρο του κύκλου. 

Θα επιτύχετε κάτι παρόµοιο µε αυτό της παρακάτω εικόνας. 

 
 

Βήµα 5ο: Κάντε κλικ στο καρέ 1, κρατήστε πατηµένο το πλήκτρο Shift και κατόπιν 

κάντε κλικ στο καρέ 15. Επιλέξτε «Shape» από την αναδιπλούµενη λίστα (pop-up 

µενού) Tween στο «Property inspector».  

 

Βήµα 6ο. Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie».  
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∆ραστηριότητα 6: ∆ηµιουργία αντικειµένων που ταυτόχρονα µετακινούνται και 
µετασχηµατίζονται 
Σε απλές περιπτώσεις θα µπορούσατε µέσα στο shape tweening όχι µόνο να 

µετασχηµατίζετε τα γραφικά, αλλά και να τα µετακινείτε· σε πιο περίπλοκες 

περιπτώσεις θα χρειαστεί να συνδυάσετε το «motion tweening» µε το «shape 

tweening». Γι αυτό θα δηµιουργήσετε ένα Movie Clip µε «shape tweening» µέσα του 

και ύστερα θα χρησιµοποιήσετε αυτό ως σύµβολο δηµιουργώντας «motion 

tweening». 

 

Βήµα 1ο.  Σε ένα νέο αρχείο επιλέξτε  «Insert  > New Symbol», δώστε του όνοµα 

“mcShapeTween” και σηµειώστε επιλογή «Movie Clip». Μέσα σ’ αυτό το Movie 

Clip δηµιουργήστε «shape tweening», όπως το µάθατε στη ∆ραστηριότητα 5 του 

παρόντος φύλλου εργασίας. 

 

Βήµα 2ο. Επιστρέψετε στην αρχική σκηνή [για να το κάνετε πατήστε την επιλογή  

Scene 1 που βρίσκεται κάτω από τη χρονογραµµή (Timeline) ]. 

 

Βήµα 3ο. Σύρτε µε το ποντίκι το Movie Clip  “mcShapeTween”  από τη βιβλιοθήκη 

στο σκηνικό. ∆ηµιουργήστε «motion tweening», όπως το µάθατε στη ∆ραστηριότητα 

3 του παρόντος φύλλου εργασίας χρησιµοποιώντας το «Movie Clip» 

“mcShapeTween” . 

 

Βήµα 4ο. Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». 

 

∆οκιµάστε να δηµιουργήσετε «shape tweening» όπως στη ∆ραστηριότητα 5 µε τη 

διαφορά ότι στο Βήµα 4ο: όχι µόνο να µετασχηµατίσετε, αλλά και να µετακινήσετε 

τον κύκλο. 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

4. ∆ηµιουργία πιο σύνθετων animations στο Flash 
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 3 διδακτικές ώρες 

 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα:  

• κατανοήσετε τις σκηνές (scenes) 

•  µάθετε να κάνετε animation µε πολλαπλές κινήσεις 

•  µάθετε να κάνετε αντιστροφή των καρέ 

• µάθετε να δηµιουργείτε κινούµενη µάσκα 

• µάθετε να δηµιουργείτε σύνθετα animations 

 

∆ραστηριότητα 1: Κατανόηση σκηνών (scenes) 
Στο περιβάλλον του Adobe Flash CS3, µπορείτε να 

χρησιµοποιήσετε περισσότερες από µία σκηνές, 

ανάλογα µε τις απαιτήσεις του project που 

σχεδιάζετε.  

Για να δείτε πόσες σκηνές υπάρχουν  στην εργασία 

σας, καθώς και να τις διαχειριστείτε, ανοίξτε το  

Scene panel (πάνελ σκηνής). 

 

Βήµα 1ο  Ανοίγετε το µενού «Window» από το 

«MenuBar» του Flash 

 

Βήµα 2ο Επιλέξτε από τα «other panels»  το «scene». 

Θα δείτε ότι εµφανίζεται το πάνελ των σκηνών, όπως 

φαίνεται στη διπλανή εικόνα. Από δω µπορείτε να 

διαχειριστείτε τις σκηνές σας, δηλαδή να προσθέσετε νέα 
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σκηνή, να δηµιουργήσετε αντίγραφο µιας υπάρχουσας ή και να διαγράψετε µια 

σκηνή. 

 

• Για να προσθέσετε νέα σκηνή στο  project σας πατήστε το εικονίδιο                          

Τι παρατηρείτε;  

....................................................................................................................................

.................................................................................................................................... 

• Για να δηµιουργήσετε ένα αντίγραφο µιας σκηνής, επιλέξτε πρώτα την σκηνή που 

θέλετε και στη συνέχεια πατήστε  Τι παρατηρείτε; 

....................................................................................................................................

.................................................................................................................................... 

• Για να διαγράψετε µια σκηνή, επιλέξτε την πρώτα και στην συνέχεια πατήστε το 

εικονίδιο      

• Για να κάνετε µετονοµασία σε µια σκηνή, πατήστε αριστερό διπλό κλικ πάνω στο 

όνοµα της σκηνής. 

• Μπορείτε να αλλάξετε την σειρά των σκηνών στο πάνελ, µε την µέθοδο «drag ’n’ 

drop». ∆ηµιουργήστε µια 2η σκηνή και σύρτε την προς τα πάνω. Τότε η 1η σκηνή 

θα µετατοπιστεί στην 2η θέση. 

 

 

 

 

∆οκιµάστε να διαγράψετε όλες τις σκηνές από το πάνελ. Τι παρατηρείτε; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Κάντε µετονοµασία 2 σκηνών και βάλτε το ίδιο όνοµα και στις 2. Τι παρατηρείτε; 

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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Σε τι εξυπηρετεί η ύπαρξη πολλών σκηνών έναντι µίας;  

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

∆ραστηριότητα 2: Πολλαπλές κινήσεις 
Σε ένα animation µπορείτε να βάλετε σύνθετες και πολλαπλές κινήσεις. 

Για να δηµιουργήσετε ένα animation που θα κάνει 

πολλαπλές κινήσεις πάνω στην σκηνή, ακολουθήστε τα 

παρακάτω βήµατα: 

Βήµα 1ο: ∆ηµιουργήστε ένα αντικείµενο της αρεσκείας 

σας, π.χ έναν χρωµατιστό κύκλο µε το «oval tool» και 

µετατρέψτε το σε σύµβολο. Τοποθετήστε το στην πάνω 

αριστερή  γωνία της σκηνής. 

 

Βήµα 2ο :Πηγαίνετε στο frame 25 και κάντε το «keyframe».  

 

 

 

 

 

Βήµα 3ο: Έχοντας επιλέγµένο το frame 25, µετατοπίστε τον κύκλο στην κάτω δεξιά 

γωνία της σκηνής,ώστε να δηµιουργηθεί το animation. 

 

Βήµα 4ο:Επιλέξτε το frame 50 και κάντε το «keyframe» και στην συνέχεια 

µετατοπίστε τον κύκλο στην κάτω αριστερή γωνία της σκηνής. 

 

Βήµα 5ο:Ακολουθείστε την ίδια διαδικασία, δηµιουργόντας «keyframe» και στο 

frame 70, µετατοπίζοντας τον κύκλο στην δεξιά πάνω γωνία της σκηνής. 

 

 

«frame 1»            «frame 25»   «frame 50»             «frame  70»  
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Βήµα 6ο: ∆ηµιουργήστε τις ενδιάµεσες 

κινήσεις του κύκλου µε την επιλογή «Create 

Motion Tween»: 

• Πατήστε δεξί κλικ πάνω σε οποιοδήποτε frame ανάµεσα στο 1 και στο 

25 και στη συνέχεια την επιλογή «Create Motion Tween». 

• Πατήστε δεξί κλικ πάνω σε οποιοδήποτε frame ανάµεσα στο 25 και 

στο 50 και ύστερα την επιλογή  «Create Motion Tween». 

• Πατήστε δεξί κλικ πάνω σε οποιοδήποτε frame ανάµεσα στο 50 και 

στο 70 και ακολούθως την επιλογή «Create Motion Tween». 

 

 

  

Παρατηρήστε ότι στην µπάρα του του Timeline ύπαρχουν τα βελάκια ανάµεσα στα 

keyframes, που  δείχνουν οτι έχουν δηµιουργηθεί τα ενδίαµεσα καρέ (frames) του 

animation. 

 

Βήµα 8ο: Επιλέξτε το 1ο frame απο το Timeline, ώστε να γυρίσει το animation στην 

αρχή και πατήστε «ΕΝΤΕR» 

Tι παρατηρείτε; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

Ποιος ο ρόλος των ενδιάµεσων keyframes (25,50) µέσα στην χρονογραµµή;  

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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∆ραστηριότητα 3: Αντιστροφή καρέ 
Σε ένα animation µπορείτε να αντιστρέψετε τα καρέ του (frames), µε αποτέλεσµα να 

αναπαράγεται αντίστροφα, δηλαδή από το τελευταίο µέχρι το πρώτο. 

 

Βήµα 1ο: ∆ηµιουργήστε ένα animation µε τον τρόπο που έχετε διδαχθεί. Για 

παράδειγµα µια κόκκινη σφαίρα, όπου θα µετακινείτε από την αριστερή πάνω γωνία 

της σκηνής, στης κάτω δεξιά γωνία µέσα σε 25 frames. 

 

 

 

 

 

 

 

 

Βήµα 2ο: Πηγαίνετε στη χρονογραµµή (Timeline) και  

επιλέξτε όλα τα frames του animation. 

 

Βήµα 3ο: Πατήστε δεξί κλικ και στις επιλογές                 

που εµφανίζονται, επιλέξτε την εντολή «reverse 

frames». Τώρα µπορείτε να τρέξετε το animation, 

πατώντας «ΕNTER» 

• Τι παρατηρείτε; 

• Ποια η διαφορά µε το πρώτο animation; 

 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................
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..........................................................................................................................................

.......................................................................................................................................... 

 

∆ραστηριότητα 4: ∆ηµιουργία κινούµενης µάσκας. 
 

Βήµα 1ο: Επιλέξτε από την εργαλειοθήκη το «text tool» 

Βήµα 2ο: Στις ιδιότητες («properties» panel) επιλέξτε την γραµµατοσειρά «Times 

New Roman», µέγεθος γραµµατοσειράς (font size) 80,χρώµα µαύρο. Επίσης, 

επιλέξτε  την «έντονη γραφή» (Bold) πατώντας το κουµπάκι «B» 

 

 

 

Βήµα 3ο: Πηγαίνετε το ποντίκι στο κέντρο και 

αριστερά της σκηνής, πατήστε αριστερό κλικ για να 

ενεργοποιήσετε το «text tool» και γράψτε το όνοµά 

σας.  

Τώρα θα µάθετε να δηµιουργείτε  ένα layer µάσκας, 

για να το χρησιµοποιείται στα σχέδιά σας. 

 

Βήµα 4ο: Πατήστε δεξί κλικ πάνω στο layer 1 και επιλέξτε «Insert layer». 

 

 

 

 

 

 

Βήµα 5ο: Αφού ελέγξετε ότι έχετε επιλεγµένο το layer 2 (καθώς θα εργαστείτε), 

πηγαίνετε στην εργαλειοθήκη και επιλέξτε το «oval tool» που βρίσκεται µέσα στο 

«shape tool». 

 

Βήµα 6ο: Πηγαίνετε στην σκηνή και σχεδιάστε 

έναν τέλειο κύκλο, µε την χρήση του πλήκτρου 

«SHIFT», µε µέγεθος λίγο µεγαλύτερο από ένα 
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χαρακτήρα. Έπειτα, µε την µέθοδο drag ’n’ drop, σύρτε προσεχτικά τον κύκλο πάνω 

στο πρώτο γράµµα, ώσπου να το καλύψετε. 

 

Βήµα 7ο: Πατήστε δεξί κλικ πάνω στο layer 2 και ενεργοποιήστε την επιλογή 

«Mask» 

 

 

 

 

 

 

Τι παρατηρείται τώρα στην σκηνή; Γιατί εξαφανίστηκαν τα υπόλοιπα γράµµατα από 

το όνοµά σας; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Τι θα συνέβαινε αν στο layer 1 είχατε τοποθετήσει µια φωτογραφία; Τι θα 

εµφανίζονταν πάνω στην σκηνή; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Τι θα συνέβαινε αν είχατε σχεδιάσει έναν κύκλο πολύ µεγαλύτερο και τον 

τοποθετούσατε πάνω στα γράµµατα; Θα είχατε το ίδιο αποτέλεσµα πάνω στην σκηνή; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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Μπορείτε να κάνετε την µάσκα να κινείτε πάνω στην σκηνή, µε τον ίδιο τρόπο που 

φτιάχνετε animation, εµφανίζοντας έτσι µόνο ότι υπάρχει κάτω από αυτήν κατά το 

πέρασµα της . 

 

Βήµα 8ο: Πατήστε πάλι δεξί κλικ στο layer 2 και απενεργοποιήστε την επιλογή 

«Mask», για να µπορείτε να βλέπετε την σκηνή και να µπορείτε να εργαστείτε. 

 

Βήµα 9ο: Επειδή µε την δηµιουργία µάσκας κλειδώνουν 

αυτόµατα τα layers, κάντε κλικ  πάνω στο εικονίδιο του 

λουκέτου, για να την απενεργοποιήσετε και να µπορείτε να 

επεξεργαστείτε τα γραφικά σας. 

 

Βήµα 10ο: Έχοντας επιλεγµένο το layer 1, πατήστε δεξί κλικ πάνω στο καρέ (frame) 

50 και εισάγετε «keyframe». 

 

Βήµα 11ο: Επιλέξτε τώρα το layer 2 και εισάγεται και σ’ αυτό «keyframe» στο frame 

50. Μετατοπίστε τον κύκλο πάνω στο τελευταίο γράµµα του ονόµατος σας, αφού 

πρώτα προσέξετε ότι είναι επιλεγµένο το frame 50 και όχι κάποιο άλλο, για να 

δηµιουργηθεί το animation. 

  

 

 

Frame 1     Frame 50 

 

Βήµα 12ο: Στο layer 2 κάντε δεξί κλικ πάνω σε ένα οποιοδήποτε frame ανάµεσα από 

το 1 και το 50 και επιλέξτε «Create Motion Tween». 
 

 

 

 

 

Βήµα 13ο: Επιλέξτε το frame 1 για να τοποθετήσετε την κεφαλή της ταινίας στην 

αρχή και στη συνέχεια µε δεξί κλικ στο layer 2, ενεργοποιήστε ξανά την επιλογή 

«Mask». 
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Πατήστε «ENTER» για να αναπαράγετε το animation κινούµενης µάσκας. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

∆ραστηριότητα 5: Εφαρµογή σε σύνθετα animations 
Με την µέθοδο «Motion Tween»  δηµιουργήσατε τα ενδιάµεσα καρέ κίνησης του 

animation. Αυτή η µέθοδος, όµως, περιορίζει την κίνηση µόνο σε µια νοητή γραµµή, 

από την θέση του αντικειµένου στο πρώτο frame µέχρι την θέση του στο τελευταίο 

frame. 

Εφαρµόζοντας τον οδηγό κίνησης (Motion guide) πάνω σε ένα layer, θα µάθετε να 

φτιάχνετε µία σύνθετη διαδροµή, στην οποία θα κινείται το animation. 

 

Βήµα 1ο: Κάντε δεξί κλικ πάνω στο layer 1 και 

ενεργοποιήστε την επιλογή «Add Motion Guide» 

 

Στο στρώµα «Guide: Layer 1» θα σχεδιαστεί η 

διαδροµή του αντικειµένου και στο στρώµα «Layer 

1» το αντικείµενο που θα ακολουθήσει την διαδροµή  

της κίνησης. 

 

Βήµα 2ο: Επιλέξτε το Guide: Layer 1 και µε το «pencil 

tool», σχεδιάστε µια διαδροµή, όπου θα περνάει το 

κινούµενο αντικείµενό σας. Προσπαθήστε να φτιάξετε µια 

διαδροµή παρόµοια µε αυτή  της διπλανής εικόνας. 

 

Βήµα 3ο: Επιλέξτε το Layer 1 και σχεδιάστε µε την βοήθεια του «oval tool» έναν 

µικρό χρωµατιστό κύκλο. 

 

Βήµα 3ο: Πατήστε δεξί κλικ στο frame 40 και εισάγετε «keyframes» 

και στα 2 Layers αντίστοιχα. 
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Βήµα 4ο: Επιλέξτε το layer του αντικειµένου (layer 1) και, αφού 

βάλετε την κεφαλή της ταινίας στο frame 1, σύρτε τον κύκλο και 

τοποθετήστε τον στην άκρη της διαδροµής. 

 

Βήµα 5ο: Τοποθετήστε τώρα την κεφαλή στο τελευταίο frame (frame 40) και σύρτε 

τον κύκλο στην άλλη άκρη της διαδροµής. 

 

Βήµα 6ο: ∆ηµιουργήστε τα ενδιάµεσα καρέ της κίνησης στο layer 1 µε την χρήση του 

«Motion Tween», γυρίστε την κεφαλή αναπαραγωγής στο frame 1 και πατήστε 

απόκρυψη του layer οδηγού, για να µην εµφανίζεται η διαδροµή. Τώρα αναπαράγετε 

το animation πατώντας «ENTER». 

 

Ποια διαδροµή ακολουθεί το αντικείµενο; 

…………………………………………………………………………………………

………………………………………………………………………………………… 

Τι θα συµβεί  αν σχεδιάσετε  ένα άλλο αντικείµενο; 

…………………………………………………………………………………………

………………………………………………………………………………………… 

Τι θα συµβεί αν κάνετε αντιστροφή των καρέ; 

…………………………………………………………………………………………

………………………………………………………………………………………… 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 
 

5. Βασικές ενέργειες και χρήση των κουµπιών στο Flash  
 
Όνοµα: 
Τάξη: 
∆ιάρκεια: 2 διδακτικές ώρες 
 
 
∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα είστε ικανοί να:  
 

• αξιοποιείται το πάνελ «Actions» και τις βασικές δυνατότητες του 
actionscripting 

• προσθέτετε ενέργειες σε καρέ   
• δηµιουργείτε ετικέτες σε καρέ  
• δηµιουργείτε βασικά κουµπιά 
• δηµιουργείτε slideshow 

 
 

∆ραστηριότητα 1: Κατανόηση του πάνελ «Actions» και των βασικών 

δυνατοτήτων του actionscripting  

Αν και κάποιες µορφές διαδραστικότητας επιτυγχάνονται και χωρίς προγραµµατισµό, 

ωστόσο σε πιο περίπλοκες περιπτώσεις χρειάζεται να γραφτεί κώδικας.  

Στην εφαρµογή Flash χρησιµοποιείται η γλώσσα προγραµµατισµού ActionScript και 

τα scripts ενσωµατώνονται στο αρχείο Flash. Για τη δηµιουργία τους χρησιµοποιείται 

το πάνελ «Actions». Το πάνελ «Actions» περιέχει συντάκτη κώδικα, έτσι ώστε να 

διευκολύνει τον προγραµµατιστή στη σύνταξη κώδικα. 

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο για να ανοίξετε το πάνελ «Actions» επιλέγετε 

«Window > Actions». Το πάνελ «Actions» αποτελείται από τρία µέρη (panes) – 

«Λίστα κατηγοριών» (Actions toolbox), «Λίστα των scripts» (Script navigator) και 

«Περιοχή script» (Script pane). 
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Βήµα 2ο: Από την αναδιπλούµενη λίστα πάνω αριστερά, η οποία περιέχει 

διαφορετικές εκδόσεις του ActionScript, επιλέξτε τη γραµµή ActionScript 1.0 & 2.0. 

Το «Action toolbox» εµφανίζει τα στοιχεία του ActionScript κατηγοριοποιηµένα. Για 

την εισαγωγή ενός στοιχείου στο «Script pane», πρέπει να κάνετε διπλό κλικ πάνω 

του ή να το σύρετε εκεί µε το ποντίκι. Επιλέξτε «Global Functions > Timeline 

Control». Θα δείτε την εντολή «stop». Κάντε διπλό κλικ πάνω της. Η  εντολή θα 

εµφανισθεί στο «Script pane». Κάποιες εντολές απαιτούν παραµέτρους και κάποιες 

όχι. Για να καταλάβετε αν η συγκεκριµένη εντολή απαιτεί παραµέτρους, κάντε κλικ 

ανάµεσα στις παρενθέσεις και ύστερα κάντε κλικ στο εικονίδιο «Show code hint»:  

 
Στο «Script pane» µέσα σε ένα κουτάκι θα δείτε «stop();», που σηµαίνει, ότι δεν 

χρειάζονται παράµετροι.  

 
 

Βήµα 3ο: Κάντε διπλό κλικ πάνω στην εντολή «gotoAndPlay». Η εντολή θα 

εµφανισθεί στο «Script pane». Για να καταλάβετε αν η συγκεκριµένη εντολή απαιτεί 

παραµέτρους, όπως και στην προηγούµενη περίπτωση, κάντε κλικ ανάµεσα στις 

παρενθέσεις και ύστερα κάντε κλικ στο εικονίδιο «Show code hint». Θα δείτε  στις 
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παρενθέσεις  «frame», που σηµαίνει ότι χρειάζεται παράµετρος – αριθµός κάποιου 

καρέ. 

 
 

Βήµα 4ο: Εισάγετε «1» ανάµεσα στις παρενθέσεις και ύστερα κάντε κλικ πάνω στο 

«Script Assist». Θα δείτε  τις εξηγήσεις για την εντολή: 

 
Μέσα στο «Script pane» µπορείτε να πληκτρολογήσετε και κατευθείαν τον κώδικά 

σας. Μπορεί να συνδυάζεται η αυτόµατη εισαγωγή κώδικα µε την πληκτρολόγησή 

του.  

Το «Script navigator» βοηθάει στην εντόπιση του κώδικα στην ταινία. Κάντε κλικ 

πάνω στο «Layer 1: Frame 1». ∆εξιά στο «Script pane» είναι ο κώδικας που 

αντιστοιχεί στο καρέ 1 «Frame 1» του επιπέδου 1 «Layer 1»: 
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Μπορείτε να γράφετε κώδικα σε οποιοδήποτε καρέ οποιουδήποτε movieclip. 

Ωστόσο, η πρακτική που προτείνει η κατασκευάστρια εταιρεία και εγκρίνει η 

κοινότητα των προγραµµατιστών είναι να συγκεντρώνεται όλος ο κώδικας σε ένα 

καρέ. 

Χωρίς τη γλώσσα  ActionScript η ταινία θα αναπαράγεται κάθε φορά µε τον ίδιο 

τρόπο. Η χρήση της γλώσσας  ActionScript επιτρέπει την διαφοροποίηση µίας 

ταινίας, ανάλογα µε την αλληλεπίδραση του χρήστη µε τα στοιχεία της ταινίας ή 

ανάλογα µε χρονικές ρυθµίσεις ή δεδοµένα προερχόµενα από µία εξωτερική πηγή. 

Στις παρακάτω δραστηριότητες θα εφαρµόσετε τη γλώσσα  ActionScript για κάτι από 

αυτά που αναφέρθηκαν. 

∆οκιµάστε να εισάγετε στο «Script pane» και άλλες ενέργειες από την κατηγορία 

«Timeline Control» και να χρησιµοποιήσετε το «Show code hint» και το «Script 

Assist» γι αυτές. 

 

∆ραστηριότητα 2: Προσθήκη ενεργειών σε καρέ   

Υπάρχουν 2 εκδόσεις της γλώσας ActionScript: η ActionScript 2.0 και η ActionScript 

3.0. Η ActionScript 3.0 είναι πιο γρήγορη όταν εκτελείται, αλλά η ActionScript 2.0 

χρησιµοποιείται ακόµα πολύ και η εκµάθησή της είναι πιο εύκολη. Τα παρακάτω 

παραδείγµατα υλοποιούνται µε την ActionScript 2.0. 

Όταν µία ενέργεια προστίθεται σε ένα καρέ, το Flash την ακολουθεί, όταν η κεφαλή 

εκτέλεσης φτάνει σ’ αυτό το συγκεκριµένο καρέ.  

Για να προσθέσετε µία ενέργεια σε ένα καρέ, ακολουθείστε τα εξής βήµατα: 
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Βήµα 1ο: Επιλέξτε ActionScript 1.0 & 2.0 από την αναδιπλούµενη λίστα στο 

«Actions toolbox».   

 
Βήµα 2ο: Σε ένα καινούργιο αρχείο Flash ονοµάστε το υπάρχον επίπεδο 

«Animation».  

 

Βήµα 3ο: ∆ηµιουργήστε µία ενότητα κειµένου µε τη λέξη «Welcome».  

 
Ο τύπος του κειµένου να είναι Static και ως χρώµα του κειµένου επιλέξτε το κόκκινο.  

 
Επιλέξτε το κείµενο και µετατρέψτε το σε σύµβολο µε το όνοµα WelcomeText και µε 

συµπεριφορά Movie Clip.  

 
 
Βήµα 4ο: Τώρα έχετε ένα στιγµιότυπο του συµβόλου αυτού στη σκηνή. Τοποθετήστε 

το στο κέντρο της σκηνής και εισάγετε καρέ-κλειδιά στα καρέ 20 και 30. 

  
 

Βήµα 5ο: Κάντε κλικ στο καρέ 1, επιλέξτε το στιγµιότυπο του συµβόλου στη σκηνή 

και εφαρµόστε σ’ αυτό µπλε χρώµα («Tint»).  
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Βήµα 6ο: Κάντε κλικ σε οποιοδήποτε καρέ ανάµεσα στο 20 και 30 στη χρονογραµµή.  

 

Βήµα 7ο: Στο πάνελ Properties από την αναδιπλούµενη λίστα Tween επιλέξτε Motion 

και από την αναδιπλούµενη λίστα Rotate επιλέξτε CW (δεξιόστροφη περιστροφή).  

 
 

Βήµα 8ο: Για να δοκιµάσετε την ταινία, επιλέγοντας «Control > Test Movie». Θα 

δείτε ότι ολόκληρη η ταινία επαναλαµβάνεται διαρκώς. Τώρα θα διαµορφώσετε την 

ταινία έτσι ώστε να επαναλαµβάνει µόνο το τµήµα που περιέχει την περιστροφή. 

  

Βήµα 9ο: ∆ηµιουργήστε καινούργιο επίπεδο (layer) και ονοµάστε το «Actions».  

 

Βήµα 10ο: Επιλέξτε το καρέ 30 στο επίπεδο «Actions», εισάγετε καρέ-κλειδί και 

εµφανίστε την παλέτα «Actions». Θα παρατηρήσετε ότι η καρτέλα λέει «Actions:30». 

Αυτό σηµαίνει, ότι ο αντίστοιχος κώδικας θα αφορά το καρέ 30 του επιπέδου 

«Actions». Θα καθορίσετε µία ενέργεια, η οποία θα εκτελείται όταν η κεφαλή 

εκτέλεσης φτάνει στο καρέ 30. 

 

Βήµα 11ο: Αριστερά στο πάνελ «Actions» βλέπετε «Actions toolbox». Επιλέξτε 

«Global Functions > Timeline Control». Μετά κάντε διπλό κλικ στο «gotoAndPlay» 

για να εισάγετε αυτό το στοιχείο στο «Script pane».  

 

Βήµα 12ο: Στο «Script pane» εµφανίστηκε η εντολή «gotoAndPlay();». Μένει να 

εισάγετε εσείς µία παράµετρο στις παρενθέσεις. Εισάγετε «20». Αυτή η εντολή 

σηµαίνει, ότι η ταινία, όταν θα φτάσει στο καρέ 30, θα µεταφερθεί αµέσως στο καρέ 

20.  
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Βήµα 13ο.  Για να δείτε τι δηµιουργήσατε επιλέξτε «Control > Test Movie». 

 

Αν σέρνατε στη χρονογραµµή το καρέ-κλειδί από το 20 σε 18 και θέλατε η ταινία να 

επαναλαµβάνει το τµήµα από την αρχή της κίνησης, τι αλλαγή θα έπρεπε να κάνετε 

στον κώδικα; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

∆ραστηριότητα 3: ∆ηµιουργία ετικετών σε καρέ   

Μπορείτε να βελτιώσετε την ενέργεια «gotoAndPlay» παρέχοντας µια ετικέτα καρέ 

αντί του αριθµού καρέ ως προορισµό της ενέργειας.  

 

Βήµα 1ο:  Στο αρχείο που δηµιουργήσατε στην προηγούµενη δραστηριότητα, κάντε 

κλικ στο καρέ 20 του επιπέδου Animation. Στο πάνελ «Properties» θα δείτε ένα 

πεδίο, στο οποίο µπορείτε να εισάγετε µία ετικέτα γι’ αυτό το καρέ. Πληκτρολογήστε 

εκεί «LoopStart».  
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Βήµα 2ο: Κάντε κλικ στο καρέ 30 στο επίπεδο «Actions» και ανοίξτε την παλέτα 

«Actions».  

 

Βήµα 3ο: Στην ενέργεια  «gotoAndPlay» αλλάξτε το 20 σε «LoopStart». Το τελικό  

script πρέπει να είναι:  

gotoAndPlay(“LoopStart”); 

 

Βήµα 4ο: Για το χρήστη η ταινία δεν θα τρέξει διαφορετικά. Όµως, τώρα µπορείτε να 

σύρετε την ετικέτα σε άλλο καρέ χωρίς να αλλάξετε το script σας.  Κάντε κλικ στη 

χρονογραµµή στο καρέ 20 και σύρετέ το έτσι ώστε το Loop Start να είναι τώρα το 

καρέ 10.  

 

Βήµα 5ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». 

 

Ποια είναι κατά την άποψή σας τα πλεονεκτήµατα της χρήσης ετικέτας καρέ αντί του 

αριθµού καρέ; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

∆ραστηριότητα 4: ∆ηµιουργία βασικών κουµπιών  

Τα κουµπιά είναι διαλογικά (interactive) movie clips που αποτελούνται από τέσσερα 

καρέ. Όταν δηµιουργείτε ένα σύµβολο και επιλέγετε τη συµπεριφορά του ως κουµπί, 

το Flash δηµιουργεί τη χρονογραµµή µε τέσσερα καρέ.  

Κάθε καρέ στη χρονογραµµή ενός κουµπιού αντιστοιχεί σε συγκεκριµένη λειτουργία: 

• Το πρώτο καρέ – κατάσταση «Up» – ο δείκτης του ποντικιού δεν είναι πάνω 

από το κουµπί. 

• Το δεύτερο καρέ – κατάσταση «Over» - ο δείκτης του ποντικιού είναι πάνω 

από το κουµπί. 
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• Το τρίτο καρέ – κατάσταση «Down» – όταν γίνεται κλικ στο κουµπί 

• Το τέταρτο κουµπί – κατάσταση «Hit» – ορίζει την περιοχή που 
ανταποκρίνεται στο κλικ και δεν είναι ορατή στην ταινία SWF 

Για να δηµιουργήσετε ένα κουµπί, ακολουθήστε τα εξής βήµατα: 

 

Βήµα 1ο:  Σε ένα καινούργιο αρχείο Flash σχεδιάστε ένα ορθογώνιο. Επιλέξτε το (µε 

διπλό κλικ) και µετατρέψτε το σε σύµβολο. ∆ώστε του όνοµα «MyButton» και 

επιλέξτε τη συµπεριφορά κουµπιού (Behavior: Button).  

 
 

Βήµα 2ο: Επιλέξτε «Control > Test Movie». Θα δείτε πώς αλλάζει ο δείκτης του 

ποντικιού, όταν τον τοποθετείτε επάνω στο κουµπί. Μετά κλείστε το παράθυρο µε 

την ταινία «SWF». 

 

Βήµα 3ο: Για να ορίσετε διάφορες καταστάσεις του κουµπιού, βεβαιωθείτε ότι στο 

µενού «Control» δεν είναι µαρκαρισµένη η εντολή «Enable Simple Buttons» και 

κάντε διπλό κλικ στο στιγµιότυπο του κουµπιού για να προσπελάσετε το πρωτότυπο 

σύµβολό του.  

 

Βήµα 4ο: Θα παρατηρήσετε ότι το σύµβολο έχει µόνο τέσσερα καρέ, τα οποία αντί 

να είναι αριθµηµένα, έχουν ονόµατα: «Up», «Over», «Down» και «Hit».  

 
Η κατάσταση «Up» περιέχει ήδη την κανονική (µη-επιλεγµένη) εµφάνιση του 

κουµπιού. Για να δηµιουργήσετε την εµφάνιση του κουµπιού στην κατάσταση 

«Over», εισάγετε ένα καρέ-κλειδί στο δεύτερο καρέ του κουµπιού. (Κάντε κλικ στο 

καρέ της χρονογραµµής κάτω από το όνοµα «Over» και µετατρέψτε το σε καρέ-

κλειδί πατώντας «F6» ή επιλέξτε «Insert > Timeline > Keyframe»). Επιλέξτε το 

εργαλείο Γεµίσµατος και διαλέξτε ένα χρώµα παρόµοιο, αλλά ελαφρώς φωτεινότερο 
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από το υπάρχον χρώµα του κουµπιού σας. Γεµίστε το σχήµα της κατάστασης «Over» 

µε το χρώµα που επιλέξατε.  

 

Βήµα 5ο: Εισάγετε ένα καρέ-κλειδί στο καρέ της κατάστασης «Down».  

 

Βήµα 6ο: Επιλέξτε όλο το περιεχόµενο του καρέ «Down» και µετακινήστε το σχήµα 

προς τα κάτω και δεξιά κατά τρία pixels πατώντας τρεις φορές τα αντίστοιχα 

βελάκια.  

 
 

Βήµα 7ο: Η κατάσταση Hit δεν γίνεται αντιληπτή από το χρήστη. Ορίζει την ενεργή 

περιοχή του κουµπιού. Είναι χρήσιµο να την ορίζετε όταν έχετε πολύ µικρό κουµπί ή 

όταν το κουµπί σας έχει σχήµα, για παράδειγµα, δακτυλιδιού (δηλαδή µε κενό στη 

µέση) και χρειάζεται να ανταποκρίνεται οπουδήποτε το επιλέξει ο χρήστης µέσα στο 

κενό. Στη δική σας περίπτωση, όπου το κουµπί έχει σχήµα ορθογωνίου δεν χρειάζεται 

να ορίσετε την κατάσταση Hit. Θα την ορίσετε στην παρακάτω δραστηριότητα. 

   

Βήµα 8ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». Το 

κουµπί σας  ανταποκρίνεται στις µετακινήσεις του ποντικιού, αλλά ακόµα δεν 

ανταποκρίνεται σε κλικ. Για να γίνει αυτό, χρειάζεται να του αναθέσετε ενέργεια. 

Αυτό θα γίνει στην επόµενη δραστηριότητα. 

 

Ποιες είναι οι βασικές καταστάσεις ενός κουµπιού και ποια είναι η χρησιµότητα της 

κατάστασης «Hit»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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∆ηµιουργήστε ένα κουµπί, όπως στα παραπάνω βήµατα, σχεδιάζοντας τη λέξη 

«Home» µε το εργαλείο «Κειµένου» αντί για το ορθογώνιο. Ορίστε και τις τέσσερις 

καταστάσεις του κουµπιού. Για την κατάσταση «Hit» σχεδιάστε µία έλλειψη. 

 

∆ραστηριότητα 5: ∆ηµιουργία slideshow   

Οι εικόνες, από τις οποίες πρόκειται να δηµιουργήσετε slideshow, πρέπει να είναι σε 

κατάλληλη µορφή. Η καλύτερη µορφή για τις φωτογραφίες είναι JPEG. Για καλύτερα 

αποτελέσµατα πρέπει να είναι µεγέθους 640 x 480 pixels και πρέπει να είναι 

αριθµηµένες, για παράδειγµα, ως photo1.jpg, photo2.jpg, και photo3.jpg. 

 

Βήµα 1ο:  Επιλέξτε «File > New» για να δηµιουργήσετε µια νέα εφαρµογή flash. Στο 

παράθυρο διαλόγου επιλέξτε την καρτέλα «Templates», από το διαθέσιµα Templates 

επιλέξτε το Template «Photo Slideshows» και πατήστε «OK». Το flash δηµιουργεί 

µια νέα εφαρµογή. Αυτή η εφαρµογή περιέχει τέσσερις φωτογραφίες. Επίσης, 

περιέχει και ένα control, µε το οποίο µπορείτε να δείτε τις φωτογραφίες µε τη σειρά, 

στη µορφή slide-show. 

 

 
 
Βήµα 2ο:  Τρέξτε την εφαρµογή (πατώντας control και enter) για να εξοικειωθείτε µε 

τη λειτουργία της.  

 

Βήµα 3ο:  Επιλέξτε το επίπεδο, το οποίο έχει όνοµα «picture layer» και διαγράψτε το.  
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Βήµα 4ο:  ∆ηµιουργήστε καινούργιο επίπεδο και δώστε του όνοµα «My Photos».  

 

Βήµα 5ο:  Τοποθετήστε το επίπεδο «My Photos» κάτω από όλα τα υπόλοιπα επίπεδα.  

 

 
 

Βήµα 6ο:  Επιλέξτε το πρώτο καρέ-κλειδί στο επίπεδο «My Photos» και ύστερα 

επιλέξτε «File > Import > Import to Stage». Εντοπίστε τις φωτογραφίες, οι οποίες θα 

σας δοθούν µαζί µε το παρόν φύλλο εργασίας. Επιλέξτε την πρώτη φωτογραφία, 

πατήστε «Open» και ύστερα «Yes» στο παράθυρο που θα εµφανισθεί: 

 
Το Flash θα τοποθετήσει τις φωτογραφίες σας σε ξεχωριστά καρέ-κλειδιά.  

 

Βήµα 7ο:  ∆ιαγράψτε τις παλιές φωτογραφίες από τη Βιβλιοθήκη.  

 

Βήµα 8ο:  Στο επίπεδο «My Photos» τοποθετήστε κάθε φωτογραφία στο κέντρο της 

σκηνής (stage) στα αντίστοιχα καρέ-κλειδιά.  

 

Βήµα 9ο:  Στο επίπεδο «Captions» αλλάξτε τις λεζάντες για κάθε φωτογραφία στα 

αντίστοιχα καρέ-κλειδιά.  
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Βήµα 10ο:  Στο επίπεδο «Title, Date» αλλάξτε τον τίτλο του άλµπουµ και δίπλα 

γράψτε την ηµεροµηνία.  

 

Βήµα 11ο:  Οι φωτογραφίες θ’ αλλάζουν κάθε 4 δευτερόλεπτα. Υπάρχει  δυνατότητα 

να αλλάξετε αυτή τη ρύθµιση. Επιλέξτε το στιγµιότυπο του flash component «mc, 

controller», το οποίο έχει βελάκια «next» και «previous» (βρίσκεται στο επίπεδο 

«_controller»). Ανοίξτε το «Component inspector» επιλέγοντας «Window > 

Component Inspector». Η καρτέλα «Parameters» θα είναι προεπιλεγµένη. Αλλάξτε 

«4» σε «5».  

 

 
 
Βήµα 12ο.  Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

6. Εξαγωγή των ταινιών του Flash  
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 2 διδακτικές ώρες 

 

∆ιδακτικοί στόχοι: 

Μετά την ολοκλήρωση των εκπαιδευτικών δραστηριοτήτων θα είστε ικανοί να:   

• εξάγετε τις ταινίες του Flash 

• ελέγχετε την τοποθέτηση και ενσωµάτωση του flash αντικειµένου σε 

φυλλοµετρητή (browser)  

• ρυθµίζετε το Flash Player   

∆ραστηριότητα 1: Εξαγωγή ταινιών του Flash 
Για τη δηµοσίευση µιας ταινίας του Flash στο Web απαιτούνται τα παρακάτω 

βήµατα: 

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο σχεδιάστε ένα ορθογώνιο που να καταλαµβάνει 

περίπου όλη τη σκηνή. 

 
 

Βήµα 2ο: Αποθηκεύστε το αρχείο σας µε το όνοµα «my_movie.fla» στο φάκελο 

«fla_files», τον οποίο δηµιουργήτε µέσα στο φάκελο «My Documents».  

 

Βήµα 3ο: Για να εξάγετε την ταινία σας, επιλέξτε «File > Publish». Θα 

δηµιουργηθούν αρχεία «swf» και «html» µε το ίδιο όνοµα «my_movie», αλλά µε 
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διαφορετική επέκταση, µέσα στον ίδιο φάκελο: «my_movie.swf» και 

«my_movie.html». 

 

Ποιος άλλος τρόπος υπάρχει για τη δηµιουργία του αρχείου «my_movie.swf» από το 

αρχείο «my_movie.fla»; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

∆ραστηριότητα 2: Έλεγχος τοποθέτησης και ενσωµάτωσης του αντικειµένου σε 

φυλλοµετρητή (browser) 

Κατά τη δηµοσίευση µιας ταινίας του Flash µπορείτε να ελέγχετε την τοποθέτηση και 

την ενσωµάτωση της σε φυλλοµετρητή (browser). Ακολουθήστε τα εξής βήµατα: 

 

Βήµα 1ο: Έχοντας ανοικτό το αρχείο «my_movie.fla» από την προηγούµενη 

δραστηριότητα, επιλέξτε «File > Publish Settings». Οποιεσδήποτε αλλαγές κάνετε 

στο παράθυρο διαλόγου «Publish Settings»,  θα αποθηκευτούν σ’ αυτό το αρχείο. Στο 

παράθυρο διαλόγου «Publish Settings» θα είναι προεπιλεγµένη η καρτέλα «Formats». 

Βεβαιωθείτε ότι οι µόνες ενεργοποιηµένες επιλογές είναι οι «Flash» και «HTML». 

Κάντε κλικ στο «OK». 
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Βήµα 2ο: Κάντε κλικ στην καρτέλα «Flash» του παραθύρου διαλόγου. Από την 

αναδιπλούµενη λίστα «Version:» επιλέξτε «Flash Player 6». Αυτό σηµαίνει, ότι η 

ταινία σας θα µπορεί να προβληθεί στα συστήµατα των χρηστών που έχουν πρόσθετο 

για το «Flash Player 6» ή µεταγενέστερη έκδοση. 

 
 

Βήµα 3ο: Κάντε κλικ στην καρτέλα «HTML». Κάθε ρύθµιση που υπάρχει σ’ αυτήν 

την καρτέλα (εκτός της ρύθµισης «Device Fonts») επηρεάζει µόνο το παραγόµενο 

HTML αρχείο. Από την αναδιπλούµενη λίστα «Template» επιλέξτε «Flash Only».  

 

Βήµα 4ο: Ορίστε την επιλογή «Dimensions:» σε «Percent» και πληκτρολογήστε 100 

στα πεδία «Width» (πλάτος) και «Height» (ύψος), έτσι ώστε η ταινία να 

καταλαµβάνει ολόκληρο το παράθυρο του φυλλοµετρητή. Βεβαιωθείτε, ότι τα 

πλαίσια ελέγχου «Loop» (επανάληψη) και «Display Menu» (εµφάνιση µενού) δεν 

είναι µαρκαρισµένα.  

 



ΤΕΤΡΑ∆ΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 60 

Βήµα 5ο: Για να τοποθετηθεί η ταινία σας στη µέση του παραθύρου, αφήστε την 

προεπιλεγµένη ρύθµιση «Center» για το «Flash alignment» - «Horizontal» και 

«Vertical». 

 
 

Βήµα 6ο: Κάντε κλικ στο OK. Οι ρυθµίσεις δηµοσίευσης αποθηκεύονται.  

 

Βήµα 7ο: Επιλέξτε «File > Publish».  

 

Βήµα 8ο: Ανοίξτε το αρχείο «my_movie.html» σε ένα φυλλοµετρητή για να δείτε τα 

αποτελέσµατα των ρυθµίσεων. 

 

Κάντε µεγέθυνση ή σµίκρυνση του παραθύρου του φυλλοµετρητή. Βεβαιωθείτε, ότι 

η ταινία καταλαµβάνει ολόκληρο το παράθυρο και βρίσκεται στη µέση του, όποιο 

µέγεθος και αν έχει το παράθυρο. 

Στη συνέχεια, εξετάστε τον κώδικα του παραγόµενου HTML αρχείου 

«my_movie.html» στο Dreamweaver.  
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∆ραστηριότητα 3: Ρυθµίσεις του Flash Player 

Ένα Flash Player αναπαράγει την ταινία µε τον ίδιο τρόπο, όπως ένας φυλλοµετρητής 

(browser).  

 

Βήµα 1ο: Στο αρχείο «my_movie.fla», µε το οποίο δουλεύατε στις προηγούµενες 

δραστηριότητες, κάντε διπλό κλικ πάνω στο ορθογώνιο και µετατρέψτε το σύµβολο 

µε τη συµπεριφορά Movie Clip. 

 

Βήµα 2ο: Εισάγετε ένα καρέ-κλειδί στο καρέ 40 της χρονογραµµής. Κάντε κλικ σ’ 

αυτό το καρέ. Με το εργαλείο «Free Transform Tool» κάντε το στιγµιότυπο του 

ορθογωνίου περίπου 2 φορές µικρότερο. 

 
 

Βήµα 3ο: Κάντε δεξί κλικ σε οποιοδήποτε καρέ µεταξύ των καρέ 1 και 40 και 

επιλέξτε «Create Motion Tween». 

 

Βήµα 4ο: Επιλέξτε «File > Save» και ύστερα «File > Publish». 

 

Βήµα 5ο: Στο φάκελο «fla_files», τον οποίο δηµιουργήσατε στη ∆ραστηριότητα 1 

του παρόντος Φύλλου εργασίας, κάντε κλικ πάνω στο αρχείο  «my_movie.swf». Το 

αρχείο θα ανοίξει στην εφαρµογή  Flash Player.  

 

Βήµα 6ο: Για να αλλάξετε τη µεγέθυνση, δοκιµάστε διαδοχικά  «View > Zoom In» 

και «View > Zoom Out». Επιλέξτε «View > Full Screen». Η ταινία θα καταλάβει όλη 

την οθόνη. Πατήστε το κουµπί «Esc» για να επιστρέψετε στην προηγούµενη 

εµφάνιση. 
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Βήµα 7ο: Επιλέξτε «Control» και, αν το πλαίσιο ελέγχου «Loop» (επανάληψη) είναι 

µαρκαρισµένο, αποεπιλέξτε το. Επιλέξτε «Control > Play» και ύστερα «Control > 

Rewind». ∆οκιµάστε διαδοχικά  «Control > Step Forward» και «Control > Step 

Back». Παρακολουθήστε τι γίνεται µε την αναπαραγωγή της ταινίας κάθε φορά.  

 
Επιλέξτε το πλαίσιο ελέγχου «Loop». Η ταινία θα επαναλαµβάνεται συνεχώς. 

 

Στην περίπτωση δηµοσίευσης της ταινίας µε χρησιµοποίηση του παραθύρου 

διαλόγου «Publish Settings», ποια ρύθµιση θα έκανε την ταινία να επαναλαµβάνεται 

συνεχώς στο φυλλοµετρητή (browser); 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

7. Περισσότερα για τη χρήση των κουµπιών στο Flash  

 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 2 διδακτικές ώρες 

 

 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα είστε ικανοί να:  

• αναθέτετε ενέργειες σε κουµπιά 

• δηµιουργείτε κουµπιά µε κίνηση (animated buttons) 

• εισάγετε δεδοµένα µε πληκτρολόγιο   

 

∆ραστηριότητα 1: Ανάθεση ενεργειών σε κουµπιά   

Σ’ αυτή τη δραστηριότητα θα δηµιουργήσετε κουµπιά, τα οποία θα επιτρέπουν στο 

χρήστη να σταµατά και να συνεχίζει µία ταινία. 

 

Βήµα 1ο: Μπορείτε να χρησιµοποιήσετε το αρχείο µε το animation, το οποίο 

δηµιουργήσατε στη δραστηριότητα 3 του φύλλου εργασίας 3. Αν δεν το έχετε, 

δηµιουργήστε το, όπως περιγράφεται εκεί.  

  

Βήµα 2ο: ∆ηµιουργήστε καινούργιο επίπεδο (layer) και ονοµάστε το «Buttons».  

 

Βήµα 3ο: Στο επίπεδο «Buttons» δηµιουργήστε ένα κουµπί, όπως περιγράφεται στο 

φύλλο εργασίας 5 .  

 

Βήµα 4ο: Θα χρειαστείτε δύο κουµπιά στη σκηνή, γι’ αυτό αντιγράψτε και 

επικολλήστε (copy and paste) το στιγµιότυπό του κουµπιού, το οποίο βρίσκεται ήδη 

στη σκηνή. Εφαρµόστε ένα διαφορετικό στυλ χρώµατος (Tint) σε κάθε στιγµιότυπο, 
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όπως µάθατε στη δραστηριότητα 2 του φύλλου εργασίας 3 – κόκκινο για το κουµπί 

«Stop» και πράσινο για το κουµπί «Play».  

 
Βήµα 5ο: ∆ώστε σε κάθε κουµπί ονόµατα «red» και «green» αντίστοιχα, 

χρησιµοποιώντας το πάνελ Properties.  

 

Βήµα 6ο: Τώρα πρέπει να αναθέσετε µία ενέργεια σε κάθε κουµπί. Πληκτρολογήστε 

τον παρακάτω κώδικα στο πάνελ «Actions» για το πρώτο καρέ-κλειδί της ταινίας: 

red.onPress = function () { 

         stop (); 

} 

green.onPress = function () { 

         play (); 

} 

 

Βήµα 7ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». Θα δείτε, 

ότι όταν πατήσετε τα κουµπιά, η ταινία θα αναπαράγεται και θα σταµατά. 

∆ηµιουργήστε ένα κουµπί, δώστε του όνοµα «MyButton» και αναθέστε του την 

ενέργεια   

 

«getURL("http://www.adobe.com", "_blank");», 

 

η οποία θα ανοίξει την ιστοσελίδα «adobe.com» σε ένα καινούργιο παράθυρο του 

φυλλοµετρητή (browser), όταν  πατήσετε το κουµπί αυτό. 

  

∆ραστηριότητα 2: Κουµπιά µε κίνηση (animated buttons) 

Μπορείτε να δηµιουργήσετε ένα κουµπί µε κίνηση (animated button), το οποίο θα 

κινείται διαρκώς. Ή µόνο όταν ο δείκτης του ποντικιού είναι πάνω του. Απλώς 

τοποθετείτε το επιθυµητό movie clip στις κατάλληλες καταστάσεις του κουµπιού. 

Σ’ αυτή τη δραστηριότητα θα δηµιουργήσετε ένα κουµπί που κινείται, όταν ο 

χρήστης περνά το ποντίκι από επάνω του: 
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Βήµα 1ο:  Σε ένα καινούργιο αρχείο  χρησιµοποιήστε το εργαλείο Κειµένου για να 

πληκτρολογήστε τη λέξη Home στη σκηνή. Στο πάνελ Properties ορίστε 30 ως 

µέγεθος του κειµένου. Επιλέξτε το κείµενο και µετατρέψτε το σε σύµβολο, δώστε του 

όνοµα «HomeText» και διατηρήστε τη συµπεριφορά «Movie Clip». 

 
 

Βήµα 2ο: Το κείµενο που είναι στη σκηνή είναι ένα στιγµιότυπο του συµβόλου 

αυτού. Τώρα θα δηµιουργήσετε ένα σύµβολο, το οποίο θα κινεί το σύµβολο 

«HomeText» στη σκηνή. Επιλέξτε το στιγµιότυπο που έχετε στη σκηνή και 

µετατρέψτε το σε σύµβολο, δώστε του όνοµα «HomeAnimation». 

 
 

Βήµα 3ο: Κάντε διπλό κλικ πάνω στο στιγµιότυπο του συµβόλου «HomeAnimation» 

που έχετε στη σκηνή για να προσπελάσετε το πρωτότυπο σύµβολό του.  

 

Βήµα 4ο:  Εισάγετε ένα καρέ-κλειδί στο καρέ 30 και ένα καρέ-κλειδί στο καρέ 15. 

Μεγαλώστε το στιγµιότυπο του συµβόλου «HomeText» στο καρέ 15. Κάντε δεξί κλικ 

σε οποιοδήποτε καρέ µεταξύ των καρέ 1 και 15 και επιλέξτε «Create Motion Tween». 

Ύστερα κάντε δεξί κλικ σε οποιοδήποτε καρέ µεταξύ των καρέ 15 και 30 και πάλι 

επιλέξτε «Create Motion Tween». 

 

Βήµα 5ο:  Επιστρέψτε στην κύρια σκηνή κάνοντας κλικ στην ένδειξη «Scene 1» 

επάνω αριστερά. Επιλέξτε «Edit > Select All» και µετά «Edit > Clear». Ανοίξτε τη 

βιβλιοθήκη επιλέγοντας «Window > Library» και σύρετε ένα στιγµιότυπο του 

συµβόλου «HomeText» στη σκηνή. 
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Βήµα 6ο: Τώρα θα δηµιουργήσετε ένα κουµπί. Επιλέξτε το στιγµιότυπο του 

συµβόλου «HomeText» και µετατρέψτε το σε σύµβολο. ∆ώστε του όνοµα 

«AnimatedButton» και επιλέξτε τη συµπεριφορά «Behavior: Button». 

 
 

Βήµα 7ο:  Κάντε διπλό κλικ πάνω στο στιγµιότυπο του συµβόλου «AnimatedButton» 

που έχετε στη σκηνή για να προσπελάσετε το πρωτότυπο σύµβολό του. Περιέχει ήδη 

ένα στιγµιότυπο του συµβόλου «HomeText» στο καρέ 1. 

 

Βήµα 8ο:  Τώρα θα τοποθετήσετε ένα στιγµιότυπο του συµβόλου «HomeAnimation» 

στην κατάσταση «Over» του κουµπιού. Κάντε κλικ στο καρέ «Over» της 

χρονογραµµής και εισάγετε ένα καρέ-κλειδί. Επιλέξτε το στιγµιότυπο και κάντε κλικ 

στο κουµπί «Swap» του πάνελ Properties. Θα εµφανισθεί το παράθυρο διαλόγου 

«Swap Symbol». 

 

Βήµα 9ο:  Στο παράθυρο διαλόγου «Swap Symbol» βλέπετε όλα τα σύµβολα που 

υπάρχουν στη βιβλιοθήκη. Μία κουκκίδα υπάρχει δίπλα στο σύµβολο, µε το οποίο 

συνδέεται το τρέχον στιγµιότυπο.  

 
Κάντε κλικ στην καταχώριση του συµβόλου «HomeAnimation» και κατόπιν κάντε 

κλικ στο «OK». Τώρα θα παρατηρήσετε ότι το όνοµα του τρέχοντος συµβόλου στο 

πάνελ «Properties» δίπλα στο «Instance of» έχει αλλάξει. 
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Βήµα 10ο:  Στο καρέ Hit κάντε ένα κλικ και εισάγετε ένα καρέ-κλειδί και σχεδιάστε 

µία έλλειψη λίγο πιο µεγάλη από τη λέξη Home. Ύστερα διαγράψτε το στιγµιότυπο 

του συµβόλου HomeAnimation στο καρέ Hit. 

 

Βήµα 11ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». 

 

∆ηµιουργήστε ένα κουµπί µε κίνηση (animated button), το οποίο θα κινείται διαρκώς. 

 

∆ραστηριότητα 3: Εισαγωγή δεδοµένων µε το πληκτρολόγιο 

Υπάρχουν πεδία κειµένου τριών ειδών στατικό (static), δυναµικό (dynamic) και 

εισαγωγής (input). 

Σ’ αυτή τη δραστηριότητα θα φτιάξετε µια εφαρµογή που θα ζητάει από τον χρήστη 

να εισάγει δεδοµένα (π.χ. το όνοµά του). 

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο  επιλέξτε το εργαλείο Κειµένου. Στο πάνελ 

«Properties» από την αναδιπλούµενη λίστα «Text Type» επιλέξτε «Input Text» και 

κάντε κλικ στο κουµπί «Εµφάνιση πλαισίου γύρω από το κείµενο» (Show Border 

Around Text). Κάντε κλικ στη σκηνή για να δηµιουργήσετε µία ενότητα κειµένου. 

 

Βήµα 2ο: Με  επιλεγµένη την ενότητα κειµένου εισάγετε το «username» στο πεδίο 

«Var»: του πάνελ «Properties». 

 
 

Βήµα 3ο: Ανοίξτε το πάνελ «Actions», κάντε κλικ στο καρέ 1 της χρονογραµµής και 

εισάγετε ενέργεια «stop();».  
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Βήµα 4ο: ∆ηµιουργήστε ένα κουµπί και τοποθετήστε ένα  στιγµιότυπό του δίπλα στο 

πεδίο κειµένου στη σκηνή. ∆ώστε του όνοµα «btnNext».  

 
Αυτό το κουµπί θα επιτρέπει στο χρήστη να προχωράει στο επόµενο καρέ. 

Πληκτρολογήστε τον παρακάτω κώδικα στο πάνελ «Actions» για το πρώτο καρέ της 

ταινίας: 

btnNext.onPress = function () { 

         nextFrame (); 

} 

Βήµα 5ο: Κάντε κλικ στο καρέ 2 της χρονογραµµής και εισάγετε ένα καρέ-κλειδί. 

∆ιαγράψτε ό,τι υπάρχει στη σκηνή σ’ αυτό το καρέ. Ύστερα κάντε κλικ στο καρέ 2 

και δηµιουργήστε ακόµα ένα πεδίο κειµένου. Στο πάνελ Properties από την 

αναδιπλούµενη λίστα Text Type επιλέξτε Dynamic Text και εισάγετε «message» ως 

όνοµα του στιγµιότυπου (Instance Name). Εισάγετε 400 ως φάρδος του (δίπλα στο 

W:). 

 
Βήµα 6ο: Πληκτρολογήστε τον παρακάτω κώδικα στο πάνελ «Actions» για το 

δεύτερο καρέ της ταινίας: 

message.text = "Welcome "+username; 

Αυτή η εντολή ορίζει την ιδιότητα «text» του στιγµιότυπου µε το όνοµα «message».  

 

Βήµα 7ο: Επιλέξτε «Control > Test Movie», µην ξεχάσετε να εισάγετε το όνοµά σας, 

και πατήστε το κουµπί για να δείτε τι δηµιουργήσατε. 

∆ηµιουργήστε στο ίδιο αρχείο και άλλο πεδίο κειµένου για να εισάγεται το επώνυµο 

του χρήστη. Θα εισάγετε το «user_last_name» στο αντίστοιχο πεδίο «Var». Για το 

δεύτερο καρέ της ταινίας θα εισάγετε τον παρακάτω κώδικα: 

message.text = "Welcome "+username+" "+ user_last_name; 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 8. Ήχοι στο Flash  
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 2 διδακτικές ώρες 

 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα µάθετε:  

• τους ηχητικούς τύπους  

• να εισάγετε ήχους  

• να χρησιµοποιείτε τους ήχους στα καρέ και να συγχρονίζετε τον ήχο µε το 

animation 

• να χρησιµοποιείτε τους ήχους στα κουµπιά  

 

∆ραστηριότητα 1: Ηχητικοί τύποι  και εισαγωγή ήχων 
Στο Flash µπορείτε να εισάγετε ήχους, αλλά δεν µπορείτε να τους δηµιουργείτε. 

Το Flash µπορεί να εισάγει ψηφιακό ήχο αποθηκευµένο στις ακόλουθες µορφές: 

• wav (µόνο για τα Windows) 

• AIFF (µόνο για το Macintosh) 

• mp3 (και για τα Windows και για το Macintosh) 

Αν έχετε στον υπολογιστή σας εγκατεστηµένο το QuickTime 4, τότε µπορείτε να 

εισάγετε ήχους και  στις ακόλουθες µορφές: 

• AIFF (και για τα Windows, και για το Macintosh) 

• Sound Designer II (µόνο για το Macintosh) 

• Sound Only QuickTime Movies (και για τα Windows, και για το Macintosh) 

• Sun AU (και για τα Windows, και για το Macintosh) 

• System 7 Sounds (µόνο για το Macintosh) 
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• wav (και για τα Windows, και για το Macintosh) 

 

Βήµα 1ο: Για να εντοπίσετε στον υπολογιστή σας αρχεία της µορφής «wav», επιλέξτε 

«Start > Search > All files and folders». 

 

Βήµα 2ο: Στο παράθυρο που θα ανοίξει, κάτω από το «All or part of the file name:» 

εισάγετε «*.wav». 

 

Βήµα 3ο: Θα παρατηρήσετε ότι υπάρχουν αρκετά αρχεία ήχου µορφής «.wav» στον 

φάκελο «C:\Windows\Media». 

 

Βήµα 4ο: Για να εισάγετε έναν ήχο σε ένα αρχείο Flash επιλέξτε «File > Import  > 

Import to Stage». Επιλέξτε ένα αρχείο ήχου µορφής «.wav» στον φάκελο 

«C:\Windows\Media».  Πατήστε το «Open».  

 
Ο ήχος θα εµφανισθεί στη Βιβλιοθήκη. 

Ελέγξτε αν υπάρχουν αρχεία µορφής «mp3» στον υπολογιστή σας. 
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∆ραστηριότητα 2: Ήχοι στα καρέ  και συγχρονισµός ήχου µε animation 
Για να χρησιµοποιήσετε τους ήχους στα καρέ ακολουθήστε τα εξής βήµατα:  

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο σχεδιάστε ένα ορθογώνιο στο πρώτο καρέ και 

µετατρέψτε το σε σύµβολο.  

 

Βήµα 2ο: Εισάγετε καρέ-κλειδιά στα καρέ 20 και 30.  

 

Βήµα 3ο: Κάντε κλικ στο καρέ 30, επιλέξτε το στιγµιότυπο του ορθογωνίου και 

µετακινήστε το στη σκηνή.  

 

Βήµα 4ο: Κάντε κλικ σε οποιοδήποτε καρέ ανάµεσα στο 20 και 30 στη χρονογραµµή.  

 

Βήµα 5ο: Στο πάνελ «Properties» από την αναδιπλούµενη λίστα «Tween» επιλέξτε 

«Motion».  

 

Βήµα 6ο: Εισάγετε το αρχείο ήχου «drums02.mp3», το οποίο σας δίνεται µαζί µε το 

φύλλο εργασίας, όπως µάθατε στην προηγούµενη δραστηριότητα.  

 

Βήµα 7ο: Ανοίξτε το παράθυρο της Βιβλιοθήκης. Εκεί θα δείτε τον ήχο που µόλις 

έχετε εισάγει.  

 

Βήµα 8ο: ∆ηµιουργήστε καινούργιο επίπεδο (layer) και ονοµάστε το «Sound».  

 
 

Βήµα 9ο: Εισάγετε καρέ-κλειδιά στα καρέ 20 και 30 του επιπέδου «Sound».  

 

Βήµα 10ο: Κάντε κλικ στο καρέ 20 του επιπέδου «Sound». Για να προσαρτήσετε τον 

ήχο στο καρέ, µπορείτε να σύρετε τον ήχο από τη Βιβλιοθήκη στη σκηνή. Όµως, 

επειδή εδώ θα ασχοληθείτε µε τις ρυθµίσεις συγχρονισµού,  προσαρτήστε τον ήχο 

στο καρέ µε άλλο τρόπο: ανοίξτε το πάνελ «Properties» και από την αναδιπλούµενη 
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λίστα «Sound» επιλέξτε τον ήχο. Γενικά, αυτή η λίστα περιέχει όλους τους ήχους που 

έχουν εισαχθεί στο αρχείο.  

 
 

Βήµα 11ο: Η ρύθµιση συγχρονισµού γίνεται από την αναδιπλούµενη λίστα «Sync:». 

«Event» είναι η προεπιλεγµένη ρύθµιση. Με αυτή τη ρύθµιση οι ήχοι αρχίζουν να 

αναπαράγονται, όταν η ταινία φτάνει στο συγκεκριµένο καρέ-κλειδί και συνεχίζουν 

να αναπαράγονται µέχρι να ολοκληρωθούν. Αφήστε αυτή τη ρύθµιση επιλεγµένη.  

 

Βήµα 12ο: Για να σταµατήσετε τον ήχο στο τέλος του animation κάντε κλικ στο καρέ 

30 του επιπέδου «Sound».  

 

Βήµα 13ο: Από την αναδιπλούµενη λίστα «Sound» επιλέξτε τον ήχο «drums02.mp3».  

 

Βήµα 14ο: Από την αναδιπλούµενη λίστα «Sync:» επιλέξτε «Stop». 

 
Βήµα 15ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». Ο ήχος 

αρχίζει ταυτόχρονα µε την αρχή του animation και σταµατάει στο τέλος του. 

 

Με ποιους τρόπους µπορείτε να εισάγετε έναν ήχο σε ένα καρέ; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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∆ραστηριότητα 3: Ήχοι στα κουµπιά    
Οι ήχοι µπορούν να προσαρτηθούν σε διαφορετικές καταστάσεις ενός κουµπιού. 

Επειδή θα αποθηκεύονται µαζί µε το σύµβολο του κουµπιού, θα λειτουργούν για όλα 

τα στιγµιότυπα του κουµπιού.   

Για να προσθέσετε ήχο στην κατάσταση «Down» του κουµπιού, ο οποίος θα 

ακούγεται όταν θα κάνετε κλικ πάνω στο κουµπί, ακολουθήστε τα εξής βήµατα: 

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο Flash δηµιουργήστε ένα κουµπί. Γι αυτή τη 

δραστηριότητα δεν  είναι απαραίτητο να ορίσετε την εµφάνιση του κουµπιού για τις 

καταστάσεις «Over», «Down» και «Hit».  

 

Βήµα 2ο: Κάντε διπλό κλικ  στο στιγµιότυπο του κουµπιού για να προσπελάσετε το 

πρωτότυπο σύµβολο του κουµπιού, δηλαδή αυτό που βρίσκεται στη βιβλιοθήκη.  

 

Βήµα 3ο: Στη χρονογραµµή του κουµπιού δηµιουργήστε καινούργιο επίπεδο (layer) 

και ονοµάστε το «Sound». 

 
 

Βήµα 4ο: Στο επίπεδο «Sound» εισάγετε ένα καρέ-κλειδί στο καρέ, το οποίο 

αντιστοιχεί στην κατάσταση «Down». 

 
 

Βήµα 5ο: Επιλέξτε αυτό το καρέ στη χρονογραµµή. Στο πάνελ «Properties» από την 

αναδιπλούµενη λίστα «Sound» επιλέξτε τον ήχο.  

 
 

Βήµα 6ο: Επιλέξτε «Event» από την αναδιπλούµενη λίστα «Sync».  
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Βήµα 7ο: ∆ηµιουργήστε το κλειδί-καρέ για το καρέ Down.  

 
 

Βήµα 8ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». Κάνοντας 

κλικ πάνω στο κουµπί, θα ακούσετε τον ήχο. 

Εισάγετε και άλλον ήχο στη βιβλιοθήκη και προσαρτήστε τον στην κατάσταση 

«Over» του κουµπιού. Θα ακούγεται όταν ο δείκτης του ποντικιού είναι πάνω από το 

κουµπί. 
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ΦΥΛΛΟ ΕΡΓΑΣΙΑΣ 

 

9. Εργασία µε βίντεο στο Flash  
 

Όνοµα: 

Τάξη: 

∆ιάρκεια: 2 διδακτικές ώρες 

 

 

∆ιδακτικοί στόχοι: 

Με το συγκεκριµένο φύλλο εργασίας  θα µάθετε:  

• να εισάγετε και να εξάγετε βίντεο στο Flash 

• να προσοµοιώνετε βίντεο στο Flash   

∆ραστηριότητα 1: Εισαγωγή και εξαγωγή βίντεο στο Flash 
Υπάρχουν διάφοροι τύποι αρχείων βίντεο, οι οποίοι µπορούν να εισάγονται σε ένα 

αρχείο Flash µε σκοπό να παρουσιάζονται online.  

Το Flash έχει πλεονεκτήµατα για την παρουσίαση βίντεο online: 

• Το Flash Player είναι πολύ διαδεδοµένο. 

• Το Flash βίντεο ενσωµατώνεται πολύ καλά στις ιστοσελίδες και µπορεί να 

εξασφαλίσει έλεγχο της αναπαραγωγής του. 

• Ένα βίντεο ελέγχεται µέσα στο αρχείο «swf», όπως κάθε άλλο αντικείµενο 

πολυµέσων, ως ένα µέρος του περιεχοµένου του. 

Η εισαγωγή βίντεο στο Flash γίνεται µε τρόπο παρόµοιο µε την εισαγωγή ήχου: µε 

επιλογή «File > Import  > Import  Video» και ύστερα επιλογή ενός αρχείου βίντεο. 

Υπάρχουν διαφορετικές επιλογές διανοµής (Deployment) κατά την εισαγωγή ενός 

βίντεο στο Flash: «Embedded», «Progressive» ή «Streaming». Κατά τις επιλογές 

«Progressive» και «Streaming» το βίντεο βρίσκεται έξω από το αρχείο «swf» του 

Flash και δεν αυξάνει το µέγεθος του αρχείου «swf». Κατά την επιλογή «Embedded» 

το βίντεο ενσωµατώνεται στη χρονογραµµή του αρχείου «fla». Επειδή αυτό αυξάνει 

το µέγεθος του αρχείου «swf», η επιλογή «Embedded» είναι  κατάλληλη µόνο για ένα 

πολύ µικρό βίντεο – έως 5 δευτερόλεπτα. 
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Σ’ αυτή τη δραστηριότητα θα εισάγετε ένα βίντεο µε την επιλογή «Embedded». Για 

να το κάνετε, ακολουθήστε τα εξής βήµατα: 

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο επιλέξτε «File > Import  > Import  Video».  

Εντοπίστε (browse) το αρχείο βίντεο «clock.avi», το οποίο σας δίνεται µαζί µε το 

φύλλο εργασίας. Πατήστε το «Open» και ύστερα το «Next». 

 

Βήµα 2ο: Επιλέξτε το «Embed video in SWF and play in timeline» και πατήστε το  

«Next». 

 

Βήµα 3ο: Αφήστε τις προεπιλεγµένες επιλογές:  

 
και πατήστε το  «Next». Θα σας ζητηθούν ρυθµίσεις για τη συµπίεση κτλ., πάλι 

αφήστε τις όπως είναι και πατήστε το  «Next» και ύστερα το «Finish». 

 

Βήµα 4ο: Ένα στιγµιότυπο του βίντεο θα είναι στη σκηνή (stage). Με το εργαλείο 

«Free Transform Tool» µικρύνετέ το λίγο.  

 

Βήµα 5ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». 

 

Βήµα 6ο: Τώρα θα εξάγετε το βίντεο, το οποίο µόλις έχετε εισάγει, ως Flash βίντεο 

σε µορφή «flv». Κάντε δεξί κλικ πάνω στο όνοµα του βίντεο στη Βιβλιοθήκη και 

επιλέξτε «Properties». 
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Βήµα 7ο: Πατήστε το κουµπί «Export» στο παράθυρο διαλόγου «Video Properties». 

Αποθηκεύστε το αρχείο σας µε το όνοµα «my_video.flv» στο «Desktop». Πατήστε το 

«OK». Όπως βλέπετε, δεν σας ζητήθηκε καµιά ρύθµιση κατά την εξαγωγή. 

 

Βήµα 8ο: Τώρα θα εισάγετε αυτό το Flash βίντεο στο αρχείο σας, το οποίο το έχετε 

ανοικτό. Επιλέξτε «File > Import  > Import  Video».  Εντοπίστε (browse) το αρχείο 

βίντεο «my_video.flv», που µόλις αποθηκεύσατε. Πατήστε το «Open» και ύστερα το 

«Next». Κάντε τις επιλογές όπως στα προηγούµενα βήµατα. Θα δείτε ότι αυτή τη 

φορά δεν σας ζητήθηκαν ρυθµίσεις για τη συµπίεση, επειδή το αρχείο είναι ήδη 

συµπιεσµένο µε τις ρυθµίσεις, οι οποίες ορίστηκαν κατά την εξαγωγή του.  

Τα αρχεία «flv», τα οποία δηµιουργούνται µε τη διαδικασία εξαγωγής από το Flash, 

µπορούν να εισάγονται µετά στα τελικά αρχεία ταινιών. Μπορούν να συνδυάζονται 

µε άλλα στοιχεία, όπως αναφέρθηκε πιο πάνω. 

Τι θα µπορούσατε να επιλέξετε αντί για το «Embed video ...» για ένα βίντεο µεγάλης 

διάρκειας; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

∆ραστηριότητα 2: Προσοµοίωση βίντεο στο Flash  
Είναι καλό να έχει ο χρήσης τον έλεγχο κατά την αναπαραγωγή ενός βίντεο – να  έχει 

στη διάθεσή του τα κουµπιά «Stop», «Play», «Resume» και «Control Volume». 

Στο Flash υπάρχει flash component FLVPlayback, το οποίο επιτρέπει τέτοιον έλεγχο 

του βίντεο. Σ’ αυτή τη δραστηριότητα θα χρησιµοποιήσετε αυτό το flash component 

και θα ορίσετε τις ιδιότητές του. 

Ακολουθήστε τα εξής βήµατα: 

 

Βήµα 1ο: Σε ένα καινούργιο αρχείο επιλέξτε «File > Import  > Import  Video».  

Εντοπίστε (browse) το αρχείο βίντεο «my_video.flv», το οποίο δηµιουργήσατε και 

αποθηκεύσατε στην προηγούµενη δραστηριότητα. Πατήστε το «Open» και ύστερα το 

«Next».  
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Βήµα 2ο: Επιλέξτε «Progressive download from a web server»  και πατήστε το 

«Next». 

 
 

Βήµα 3ο: Εµφανίζονται επιλογές για το flash component FLVPlayback. Από την 

αναδιπλούµενη λίστα «Skin» επιλέξτε «SteelExternalNoVol.swf».  

 
Πατήστε το «Next» και ύστερα το «Finish». Στη σκηνή (Stage) εµφανίζεται η 

περιοχή του βίντεο και τα κουµπιά ελέγχου. Με το εργαλείο «Free Transform Tool» 

ρυθµίστε το µέγεθός του. 
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Βήµα 4ο: Για να δείτε τι δηµιουργήσατε, επιλέξτε «Control > Test Movie». Πατήστε 

όλα τα κουµπιά ελέγχου για να δείτε πώς λειτουργούν. 

Επαναλάβετε τα βήµατα της παρούσας δραστηριότητας, επιλέγοντας στο Βήµα 2ο 

«Stream from Flash Media Server» αντί για το «Progressive download from a web 

server» . Στο Βήµα 3ο  επιλέξτε άλλο «Skin» από την αναδιπλούµενη λίστα. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


